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Safety instructions and device components

1	 Safety instructions and device components
1.1	 Safety instructions

	 Electrical devices may only be mounted and connected by electrically skilled persons. 

Serious injuries, fire or property damage possible. Please read and follow manual fully.
Danger of electric shock. During installation and cable routing, comply with the regulations and 
standards which apply for SELV circuits.
These instructions are an integral part of the product, and must remain with the end customer.

1.2	 Device components

Fig. 1: Device components

1 Installation box
2 Adapter
3 Smart Panel

2	 Function
2.1	 System information

This device is a product of the KNX system and conforms to the KNX Directives. Detailed knowledge 
attained through KNX training is a prerequisite for understanding.
The device is planned, installed and commissioned by means of external project planning software. The 
latest software version and the technical descriptions can be found on our website at all times.

2.2	 Intended use
	- Visualising and operating system statuses and information on building automation
	- Mounting horizontally (recommended) or vertically
	- Mounting in a flush-mounted installation box or on appliance box with dimensions according to DIN 49073 
(recommendation: at a depth of approx. 60 mm)

1
2

3
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Function

2.3	 Product characteristics
	- High-resolution HD display
	- Proximity sensor
	- Capacitive touch screen
	- Cleaning mode with touch screen lock
	- Fanless, without mechanical moving parts
	- Integrated bus coupling unit
	- Graphical user interface for visualisation and operation of KNX devices
	- Project design with the Windows software “KNX Smart Panel Designer” 
(Minimum requirements: Windows 10, 64-bit, 120 MB free memory)

	- Commissioning with ETS of Version 5.7.4 or higher and DCA
	- KNX special functions, e.g. scenes, sequences, central function, presence simulation
	- Areas or elements: Max. 300
	- Structured by multiple levels, areas or functions
	- Time planning: Max. 125, each with 10 commands
	- Logic operations: Max. 55
	- Astronomical clock
	- Visualisation of the indoor and outdoor temperature
	- Automatic average temperature per area or room
	- Messages (alarm, warning, information)
	- E-mail notifications
	- Push notifications
	- Favourites page
	- Light / dark colour scheme
	- Two-level configuration access (admin / user)
	- User management
	- User (PIN codes): Max. 10
	- PIN protection for areas / elements
	- Backup and restore
	- Mobile app
	- Secure remote access via myJUNG account
	- App users per installation: Max. 10

2.4	 Included in delivery
	- KNX Smart Panel 8
	- Smart Panel Adapter for wall installation
	- Operating instructions
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Mounting and electrical connection

2.5	 Requirements
Requirements for JUNG Smart Vision are:
	- 1 x JUNG KNX Smart Panel 8
	- 1 x Windows PC with JUNG KNX Smart Panel Designer Software 
(Minimum requirements: Windows 10, 64-bit, 120 MB free memory)

	- 1 x ETS product data base for JUNG KNX Smart Panel 8 and corresponding DCA (Device Configuration 
App)

Optional:
	- Local network (LAN) 
	- Mobile devices (smartphone, tablet, etc.) with iOS or Android operating system

Explanation: 
This manual describes the product KNX Smart Panel 8 and the JUNG SMART VISION application. JUNG 
Smart Vision is pre-installed as an app on the JUNG KNX Smart Panel 8 and is used to visualise and 
operate system statuses within the KNX building automation. A PC version of the software for Windows 
operating systems, the JUNG KNX SMART PANEL DESIGNER, is used for the project design and 
commissioning of JUNG Smart Vision. With the JUNG KNX Smart Panel Designer, you can configure 
the user interface of the JUNG Smart Vision App to meet your requirements. The programming of the 
device then takes place solely using ETS 5.7.4 and higher, as well as with the corresponding DCA (Device 
Configuration App within the ETS).

The JUNG KNX Smart Panel 8 is a standalone system for KNX visualisation. It plays both the client and 
server roles. The client role consists of allowing the control of the KNX system using graphical elements. 
The server role consists of managing the communication between the KNX and graphical interface in both 
directions. In addition to the KNX visualisation JUNG Smart Vision, further JUNG apps for support, updates, 
SIP door communication and the JUNG Camera app are installed. Remote access is possible from firmware 
version R4.7.

	i A myJUNG account and remote access licence (ref. no. SP-REMOTE-L) are required for remote access.

3	 Mounting and electrical connection
3.1	 Information for electrically skilled persons

DANGER 
Electrical shock on contact with live parts in the installation environment. 
Electrical shocks can be fatal. 
Before working on the device, disconnect the power and cover live parts in the area.

3.2	 Mounting in installation box or appliance box
The Smart Panel is designed for mounting in a flush-mounted installation box. The Smart Panel adapter is 
screwed onto the installation box.
Installation boxes from other manufacturers must match the overall dimensions and holes of the adapter and 
the Smart Panel. (See technical data for overall dimensions)
The installation box must be precisely aligned and mounted flush in the wall.
Alternatively, an appliance box with dimensions according to DIN 49073 can be used for mounting the Smart 
Panel. The Smart Panel adapter is not mounted directly on the appliance box, but on the wall.
The recommended depth of the appliance box is approx. 60 mm.
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Mounting and electrical connection

3.3	 Mounting adapter

83
58

Fig. 2: Mounting adapter

1 Adapter locking screw
2 Fixing hooks

•	 Mount the adapter on the installation box with a total of four locking screws (1). (fig. 2) 
When mounting on an appliance box, the adapter must be mounted on the wall. The adapter must be 
placed in such a way that the appliance box is located in the indentation of the adapter. The appliance box 
is thus not located vertically in the centre of the adapter, but with a downward offset.

1

2

2

1

1

1

2

2
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Mounting and electrical connection

3.4	 Connection

Fig. 3: Connection

3 Power supply 5 LAN/Ethernet
4 USB 6 KNX bus

Requirements:
	- KNX/EIB bus connection
	- Power supply via power supply adapter, ref. no.: NT 2415 REG VDC
	- For firmware updates, support, IP cameras, SIP door communication or operation via mobile end devices: 
Ethernet connection

•	 Connect the power supply (3) and KNX (6). (fig. 3)
•	 Connect LAN (5) optionally.

	i Do not connect any other products and loads outside the KNX standard to the bus output. The bus 
communication could be affected by this.

4

6

3

5
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Commissioning

3.5	 Mounting Smart Panel

Fig. 4: Mounting Smart Panel

8 Openings for wall mounting
9 Smart Panel locking screws

•	 Place the openings for wall mounting (8) on the Smart Panel on the fixing hooks (2) on the adapter.  
(fig. 2 and fig. 4) 
To do this, place the openings for wall mounting above the hooks and engage them downwards.

•	 Fasten the Smart Panel to the adapter on the underside with a total of two locking screws (9). (fig. 4)

4	 Commissioning
4.1	 Switching on

After connecting, the device is switched on automatically and the operating system is started.
After the start-up process, you must make the settings for commissioning.

4.2	 Settings – overview of the menu structure
	- General

	- Language
	- Date/time

	- Design
	- Display
	- Advanced

	- System password

9

8

8

9

8

8
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4.3	 Opening the settings
•	 Select the JUNG logo in the main menu (JUNG Launcher). 
The password entry opens.

•	 Enter the system password. 
The default system password is “0000“. 
The settings open.

4.4	 Selecting the language
•	 Open the settings.
•	 Select the menu “General”.
•	 Select the submenu “Language”. 
Available languages are displayed.

•	 Select the language. 
The language is selected.

4.5	 Selecting date and time
•	 Open the settings.
•	 Select the menu “General”.
•	 Select the submenu “Date/time”.
•	 Make the settings:

	- Autom. date/time: activated
	- Autom. time zone: Deactivated
	- Select the time zone (e.g. GMT+2)
	- 24-hour format: Activated

4.6	 Changing the system password
	i The system password grants access to all settings. The user password grants only limited access to the 
settings.

•	 Open the settings.
•	 Select the menu “Advanced”.
•	 Select the submenu “System password”. 
The password entry opens.

•	 Enter the current and new system password.
•	 Confirm passwords with the “OK” button. 
The system password is changed.

4.7	 Updating the firmware
Prerequisite: Internet connection
•	 Select the app “System update”. 

The app is started.
•	 Select “Search for updates online”. 
The firmware is updated automatically.
	i If there is no Internet connection, a USB storage medium can be used to update the firmware.
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Operation

5	 Operation
5.1	 Operating elements

Fig. 5: Operation

Name Function
1 Proximity and brightness 

sensor
For the automatic switch-on of the display and automatic 
adjustment of the display brightness

2 Loudspeaker To play signal tones
3 Microphones To record speech
4 HOME button To return to the main menu (JUNG Launcher) and switch the 

device off/on

Display main menu
•	 Press the HOME button briefly 1x. 
The main menu (JUNG Launcher) is displayed.

Switch device off/on
•	 Keep the HOME Button pressed for 5 seconds. 
The operating system is powered down and the device switched off.

•	 Press the HOME button briefly 1x. 
The device is switched on and the operating system launches.

3

1

22

43
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Operation

5.2	 Control elements
Control elements are available for the operation and configuration of the device.
The control elements are not displayed in all the menu areas and apps and can be hidden as necessary.

Fig. 6: Control elements

Name Function
A Status bar Display of the time 

Display of status messages of launched apps
B Navigation bar Contains basic control elements

1 Off/Restart To restart or switch off the device
2 Quieter To reduce the volume
3 Back Goes back to the previous menu
4 Main menu Goes directly to the main menu (JUNG Launcher)
5 App overview Opens an overview of all launched apps
6 Louder To increase the volume
7 Context menu Opens the context menu

Opening the status bar
•	 Perform a swipe movement from the top edge of the touch screen to the centre 

Status bar opens.

B

A

1 2 3 5 6 74
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5.3	 Device settings
Besides the settings for commissioning the device, additional device settings can be performed. The 
device settings can be opened in the main menu using the JUNG Launcher (see “Open settings” in the 
Commissioning chapter at page 10).

Overview of the menu structure

	- General
	- Language
	- Date/time
	- Network and connectivity
	- Show navigation notification
	- Show navigation bar
	- Show virtual power button
	- NTP
	- NTP server

	- Design
	- Orientation
	- Theme
	- Background
	- Dashboard
	- App area

	- Display 
	- Display settings
	- Display power management
	- Display wake-up sensor settings
	- Adaptive brightness
	- Lockscreen

	- Advanced
	- System password
	- User password
	- Welcome message
	- Autostart
	- Automatic reboot
	- App starter
	- Cache cleaner
	- App guard
	- App terminator
	- Support access
	- Config-Tool access
	- App management
	- Volume control
	- Memory
	- Account management
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Operation

5.4	 Operation using apps in the main menu
The device is operated via pre-installed apps.
The apps must be started via the main menu.

Fig. 7: Main menu (JUNG Launcher)

5.5	 Apps for building automation
Software applications for building automation are already pre-installed on the device as apps.
Depending on the system used, only certain apps can be used.
The apps are used to visualise system states and to control individual components.

Pre-installed apps on the KNX Smart Panel 8:
	- JUNG Smart Vision
	- JUNG Camera
	- QuickSupport
	- System Update
	- Screencleaner
	- JUNG SIP-Client (Intercom)

	i The device is supplied with all the apps required to control the KNX building automation. No apps from 
other third parties should be installed. JUNG cannot guarantee that external apps will function on the 
device under all circumstances. A third-party app which does not function does not represent grounds for 
a complaint.

	i In the delivery state, the apps JUNG Smart Vision, JUNG Camera, QuickSupport, System Update, 
Screencleaner and JUNG SIP-Client are already linked in the main menu.
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5.6	 Create app link in the main menu

Fig. 8: Create app link in the main menu

•	 Touch an area/tile in the main menu for a long period of time. 
The app list is displayed.

•	 Select an app. 
A query regarding the icon and name opens.

•	 Change or keep the icon and name.
•	 Confirm the settings using the “Assign” button. 
The app link is displayed in the main menu.
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Operation

5.7	 “JUNG Smart Vision” app
JUNG Smart Vision is pre-installed as an app on the KNX Smart Panel 8 and is used to visualise and 
operate system statuses within the KNX building automation.

Fig. 9: “JUNG Smart Vision” app

Name Function
A Status and navigation 

bar
Display of connection icon and status
Icons for the indication of menus and for navigation
Display of time, date and temperature

B Building visualisation Overview of all areas of the building
View of a selected area of the building
Detailed view of an element within the building

C Menu Display of menus (e.g. settings)

BC

A
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5.7.1	 Status and navigation bar

Fig. 10: JUNG Smart Vision – Status and navigation bar

Up to seven navigation icons are displayed in the Status and navigation bar.

Icon Name Explanation
Back* Superordinate area of building visualisation

Favourites Quick access to frequently used functions

Messages Current and archived messages, such as error messages

Home top area of the building visualisation

Settings Menu for app settings

Plugins Extensions for special functions

Building structure (TreeView)* Hierarchy with direct access to areas and functions

* Only available from firmware version R4.10.

Besides the current date and time, it is also possible to display the indoor and outdoor temperatures. Both 
values can be linked to the ETS using communication objects.

Icon Name Explanation
Indoor temperature Actual temperature value in the room

Outdoor temperature Actual temperature value outside the building

The connection icon displays the current status of the connection between the Smart Vision app and the 
Smart Panel.

Icon Name Explanation
Unknown Status of the connection is not known or is being determined

Offline No connection

Offline programming No connection, changes will be saved locally and synchronised later

Error Could not set up connection

Trying to connect Setting up connection

Wait for core services Connection has been set up but the core services are not yet ready

Connected locally Connection available via the local network

Connected to cloud Device is connected through the cloud, remote access is possible

Demo mode Demo project is displayed, changes will not be saved
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5.7.2	 Building visualisation (Home)
The building visualisation distinguishes between areas and elements.
Areas
An area can consist of several rooms or elements. Several areas can also be nested under each other and 
thus organised into levels.
Levels/rooms are simply referred as “areas”.

	i Areas were referred as “rooms” prior to firmware version R4.10.

Elements
(KNX) functions are referred as “elements”.
IMPORTANT: 
A max. of 300 areas or elements can be created. 
A max. of 1,000 communication objects can be linked.
Area overview

Fig. 11: JUNG Smart Vision – Building visualisation area overview

All created areas are displayed in the area overview.
This view is defined as the home of the visualisation, which is always accessible via the house icon in the top 
bar. The first 6 areas are represented in corresponding tiles by names, backgrounds and central functions. 
Further areas can be accessed by scrolling down/up. The content of the area or the detailed view of the 
desired element can be accessed by clicking on a tile.
	- A max. of 6 areas are indicated in the grid.
	- Vertical scrolling: Navigation to other areas
	- Click on the tile: Jump to the area / element
	- Central function tile: Bottom left (light/blinds/music)
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Content of an area

Fig. 12: JUNG Smart Vision – Building visualisation content of an area

	- The display shows up to 5 of the first elements of the respective area.
	- The tile at the top left shows the area including the name and central functions.
	- Vertical scrolling: Navigation to further elements
	- Click on the tile: Jump to the detailed view

Central functions
Central functions can be created for each area according to requirements and the contents. These can be 
operated from this view. There is a central switch for light, Venetian blinds and music and a display of the 
average area temperature. 
These functions become available as soon as at least one element corresponding to the appropriate type is 
added to the area (i.e. at least 1 x light, 1 x Venetian blind switch, 1 x thermostat or 1 x music element) AND 
central functions are activated in the settings for the area. 

Icon Name Explanation
Light Switch light in area on / off

Venetian blinds down Move all Venetian blinds in the area down 

Venetian blinds up Move all Venetian blinds in the area up

Music Play / pause music in the area

Temperature Indication of the actual value (average) of all temperatures in the area
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Detail view of an element
The detail view of an element is the lowest navigation point within the hierarchy level.
Here, the element is offered for operation with all its functions. 

Fig. 13: JUNG Smart Vision – Visualisation area, detail view

All the elements share the following function icons (if activated):

Icon Name Explanation
Time planning Open/edit detail view for time planning

Sequence Open/edit detail view for sequence

Favourite Add element to Favourites

Close detail view Detail view view closed, area is displayed
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5.7.3	 Building structure (TreeView)
	i This view is only available from firmware version R4.10.

The building structure clearly displays all created areas and elements of a building or project.
The hierarchical display within the tree structure makes it easier to find a desired area or element and 
enables direct access to it.

Fig. 14: JUNG Smart Vision - Building structure (TreeView)

In the structure, areas and elements can not only be displayed, but also selected.
You can navigate directly to the selected area or element by clicking on the respective entry.
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5.7.4	 “Settings” menu

Fig. 15: JUNG Smart Vision – “Settings” menu

The menu can be opened using the cog icon in the Status and navigation bar. 
Settings can only be edited or changed when logged in as an Administrator. The cog icon appears in colour if 
you are logged in as an Administrator or non-standard user.

Icon Name Explanation
Opening the settings The "Settings" menu is opened (press it again to close it)

Settings as Administrator 
(blue icon)

The "Settings" menu is opened, log-in as an Administrator has taken 
place, additional functions and submenus are displayed

Close settings "Settings" menu is closed
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Log user in as Administrator

Fig. 16: JUNG Smart Vision – Password entry for log-in as an Administrator

•	 Select “Login” in the “Settings” menu. 
The password entry opens.

•	 Enter the Administrator password. 
The default Administrator password is: 74269

•	 Confirm the entry with “OK”. 
User is logged in as an Administrator. 
The cog icon is displayed in blue. 
Advanced functions and submenus are displayed.

Log user out as Administrator
•	 Select “Logout” in the “Settings” menu. 

User is logged out as an Administrator. 
The cog icon is displayed in white (transparent). 
Advanced functions and submenus are hidden.
	i The user is logged out automatically after 15 minutes without activity.



Page 24 of 127SP 008 1U

Configuration

6	 Configuration
6.1	 KNX Smart Panel Designer

The first step is to create the project using the KNX Smart Panel Designer. There, all the rooms, elements, 
time planning, scenarios, logic operations, etc. are created and edited until the desired result has been 
achieved. This configuration is then exported to a desired folder on the PC in the KNX Smart Panel Designer 
under “Configuration → Export/Import → Export”. The resulting project file has the ending *.ksp (see “Export/
Import” submenu on page 72). 

6.1.1	 Downloading, installing and launching
The software is available on our website as a free download. Install the KNX Smart Panel Designer on your 
laptop or PC and launch the application.
IMPORTANT: 
Please note update instructions or release notes!

6.1.2	 Operation
The software is operated in the same way as the “JUNG Smart Vision” app is operated.
You can find an overview of the areas of the app at page 13.
Further basic operation principles can be found here:
Open settings 
Description see page 22
Log user in as Administrator 
Description see page 23 
The default Administrator password is: 74269
Activate configuration mode
After launching the KNX Smart Panel Designer, the user is automatically logged in as an Administrator and 
configuration mode is already activated. This means that manual activation of the configuration mode is not 
usually required.

Fig. 17: Smart Panel Designer – Activate configuration mode

Precondition: 
User is logged in as an Administrator.
•	 Activate configuration mode using the toggle switch in the “Settings” menu. 

The Plus icon for adding a new area or element is shown.

Icon Name Explanation
New area /  
new element

Add a new area / new element (configuration mode must be 
activated)



Page 25 of 127SP 008 1U

Configuration

6.1.3	 Creating new projects or importing existing projects
A new project is created on starting the KNX Smart Panel Designer. New projects do not contain any rooms, 
elements or functions.
Existing project files can be used as the basis for new projects. The project files with the file ending .ksp 
must be imported via the menu “Configuration → Export/Import → Import” (see “Export/Import” submenu 
on page 72).

6.1.4	 Creating and configuring areas

Fig. 18: Smart Panel Designer – Creating and configuring areas

Preconditions: 
User is logged in as an Administrator. 
Configuration mode is activated.
•	 Add a new area using the Plus icon. 
The “Add new” menu is displayed.
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“Add new” menu
	- Background image: 
A room sketch can be defined for each room using “Add new → Background → Image”. Currently, 35 
different room sketches are available:

	i You cannot integrate your own sketches.  
The library is continually being expanded and extended with future updates.

	- Central functions: 
For each area, various central functions (light/Venetian blind/music/average temperature) can be assigned 
as necessary using “Add new → Central functions”. 
Description see page 19

	- Visibility: 
In addition, visibility is also possible for unauthorised persons, i.e. for users who are not permitted to 
control the central functions due to their user rights. As standard, visibility is not active for unauthorised 
people.

Fig. 19: Smart Panel Designer – “Add new” menu

•	 Enter the name for the area.
•	 Optionally, select a background image.
•	 Show or hide central functions as an option.
•	 Optionally, configure authorisations and visibility in the “General” submenu.
•	 Confirm the configuration with a checkmark. 
The newly added area is displayed in the building visualisation.
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6.1.5	 Creating and configuring elements

Fig. 20: Smart Panel Designer – Creating and configuring elements

Preconditions: 
User is logged in as an Administrator. 
Configuration mode is activated.
•	 Add a new element using the Plus icon. 
The “Add new” menu is displayed.
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“Add new” menu
	- Parameters: 
Under “Parameters”, additional setting options are available, depending on the element type. For certain 
elements, icons, for example, can be taken from the internal library for further personalisation. In addition, 
some elements possess individual setting options with regard to operation and KNX functionality.

	- Attribute (available from firmware version R4.9): 
The assignment of data points within an element can be changed via the “Attribute” menu item. In addition 
to KNX group addresses, internal variables can also be linked and used for process automation. Internal 
variables must be explicitly created and assigned. 
Description see page 29

	- Authorisations: 
If necessary, an element can be given different access rights. The access rights of different users can be 
individualised for an element under “Add new → General”. 
Description see page 56

	- Visibility: 
Description see page 32

	- Block: 
Description see page 33

Fig. 21: Smart Panel Designer – “Add new” menu

•	 Select the type of element. 
Additional configuration options become visible, depending on the type of the element. 
The following sections shows the options for the On/Off type (e.g. switch) by way of an example.

•	 Enter the name for the element.
•	 Optionally, configure parameters.
•	 Optionally, change attribute (modification of the linked data points).
•	 Optionally, configure authorisations, visibility and additional functions in the “General” submenu.
•	 Optionally, configure blocks. 

Description see page 33
•	 Confirm the configuration with a checkmark. 
The newly added element is displayed in the building visualisation.
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Changing attribute of an element
From firmware version R4.9, the data points within an element can be changed. Within the device, a 
data point is an abstract intermediate layer between driver-specific addresses and the internal software 
framework. Data points can be linked either as KNX group addresses or as internal variables. This reduces 
the number of (ETS) communication objects required for process automation and enables the combination of 
internal variables and KNX group addresses when programming logics, schedules or sequences.

	i The KNX group address is predefined as the default link for the data points of an element.
•	 Select element for editing. To do this, hold down the left mouse button or click on the right mouse button 

(see “Editing, copying or deleting areas/elements” on page 34).

Fig. 22: Smart Panel Designer – Attribute of an element

•	 Select attribute of the element. 
The current data point link of the attribute is displayed.

Fig. 23: Smart Panel Designer – Attribute’s data point link

•	 Select the attribute’s data point link. 
The attribute’s default link is displayed.
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Fig. 24: Smart Panel Designer – Attribute’s standard link

•	 Deactivate standard link with the toggle switch. 
Internal variable of the attribute is displayed.

Fig. 25: Smart Panel Designer – Attribute’s internal variable

•	 Select the internal variable of the attribute or add it with the plus sign. 
Existing internal variables are displayed.
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Fig. 26: Smart Panel Designer – Selection or creation of internal variable

•	 Select an existing internal variable or add a new variable with the plus sign. 
Internal variable is linked to the attribute of the element. 
Current data point link of the attribute is displayed.

Fig. 27: Smart Panel Designer – Verification data point link

•	 Verificate the current data point link.
•	 Confirm settings with the tick symbol.
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Hide element
If necessary, an element can be switched to be visible/invisible. The element is then only visible within the 
project design software and is shown transparently. This does not apply for later depiction on the display. 
However, this means that there is no need to create the element again. It is hidden when shown on the 
display.

Fig. 28: Smart Panel Designer – Hide element

•	 Select the “General” menu in the settings of the appropriate element.
•	 Deactivate visibility with the toggle.
•	 Confirm the settings with a checkmark. 
Settings for visibility are applied. 
The element is displayed semi-transparently.

Fig. 29: Smart Panel Designer – Invisible element
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Blocking an element
The “Activate block” option generates a communication object for later linking within the ETS. The 1-bit 
object can be used to block and unblock the element on the user interface (enable). If necessary, the value 
for “Blocked/unblocked” can be inverted and the behaviour of the element on blocking (no action/on/off) can 
be set. A blocked element can be seen on the Smart Panel in the overlay with a lock symbol. 

Fig. 30: Smart Panel Designer – Block element

•	 In the “Add new” menu, activate the block of the appropriate element using the toggle switch.
•	 Optionally, invert the value block.
•	 Optionally, configure the behaviour on a block.
•	 Confirm the settings with a checkmark. 

Settings for the block are applied. 
The element is displayed in JUNG Smart Vision with a lock icon.

Fig. 31: JUNG Smart Vision – Blocked element
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Editing, copying or deleting areas/elements

Fig. 32: Smart Panel Designer – Changing, copying or deleting areas/elements

•	 Select the area/element with a long press of the left mouse-button or clicking the right mouse-button. 
Icons for editing are displayed.

Icon Name Explanation
Change Change area/element

Copy Copy area/element

Delete Delete area/element

Cancel edit Editing is cancelled, icons are hidden

•	 Select the symbol by clicking on the left mouse button. 
A separate window with the building structure opens for copying/moving.

Fig. 33: Smart Panel Designer – Changing or copying areas/elements
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6.1.6	 Configure time planning for an element
Preconditions: 
User is logged in as an Administrator. 
Configuration mode is activated.
Activate time planning

Fig. 34: Smart Panel Designer – Activate time planning

•	 Select the “General” menu in the settings of the appropriate element.
•	 Activate time planning with the toggle switch.
•	 Confirm the settings with a checkmark. 

Settings for time planning are applied.
Create time planning

Fig. 35: Smart Panel Designer – Create time planning

•	 Display detailed view of the element.
•	 Select the time planning icon. 
“Time planning: Overview” is displayed.
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Add a task to the time planning

Fig. 36: Smart Panel Designer – Add a task to the time planning

•	 Add time planning to the element using the Plus icon. 
“Time planning: Task list” is displayed.

Create a task for time planning

Fig. 37: Smart Panel Designer – Create task for time planning

•	 Enter a name for the task and select a time period for the validity.
•	 Add a task to the time planning using the Plus icon. 
“Time program: Details” is displayed.
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Select a time point for task execution

Fig. 38: Smart Panel Designer – Select a time point for task execution

•	 Select a time point for task execution. 
To do this, either select the time and repeats or select sunrise/sunset.

	i Sunrise/sunset is only available if the astronomical clock was activated. 
Description see page 62

Add an action to the time planning

Fig. 39: Smart Panel Designer – Add an action to the time planning

•	 Add an action for time planning to the element using the Plus icon. 
The action is added to the action list. 
The new time planning is displayed in “Time planning: Overview”. 
Optionally, configure element-specific functions of the action.
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Editing, deactivating or deleting the time planning

Fig. 40: Smart Panel Designer – Editing, deactivating or deleting the time planning

•	 Select the time planning to be edited directly, deactivate it with the toggle switch or delete it using the 
Minus icon.

	i The “All” button can be used to display an overview of all time plans for each area or each element. 
It is also possible to view all time plans in the plug-ins. To do so, first activate the time plane overview in 
the plug-ins. 
Description see page 70
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6.1.7	 Configure sequences for an element
Preconditions: 
User is logged in as an Administrator. 
Configuration mode is activated.
Activating a sequence for an element
In generally, only those elements can be included in sequences that were previously activated for it. 
Activation takes place in the “General” menu in the appropriate element.

Fig. 41: Smart Panel Designer – Activating a sequence for an element

•	 Select the “General” menu in the settings of the appropriate element.
•	 Activate sequences with the toggle switch.
•	 Confirm the settings with a checkmark. 
Settings for the sequences are applied.
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Creating a sequence

Fig. 42: Smart Panel Designer – Create sequence

•	 In the content view of the appropriate area, add a new element of type “Sequence” with the Plus icon.
•	 Display detailed view of the new element.
•	 Select the sequence icon. 
“Configure sequence” is displayed.

Configuring a sequence

Fig. 43: Smart Panel Designer – Configure sequence

•	 Add elements to the sequence with the Plus icon. 
The elements must be activated for sequences. 
Description see page 39

•	 Optionally, configure a delay and further settings of the elements.
•	 Confirm the settings with a checkmark. 
Settings for the sequence are applied.
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6.1.8	 Configure advanced settings
In addition to the design of the user interface, additional options can be found under “Settings” for special 
functions, logic operations, messages, time plans and user management. These setting options are 
explained in the following subchapters.
Preconditions: 
User is logged in as an Administrator. 
Configuration mode is activated.

Overview of the menu structure
	- Configuration

	- Resources
	- Visualisation

	- Design
	- Drivers

	- KNX
	- Twisted Pair

	- Internal variables
	- Logic operations
	- Messages

	- Messaging signal length
	- Messages
	- E-mail recipient
	- SMTP server

	- User management
	- Users
	- Permission matrix

	- Plugins
	- Astronomical clock
	- Synchronise date/time
	- Presence simulation
	- Sequence button
	- Time plan overview

	- Export/Import
	- Export
	- Import
	- Reset

	- System
	- Update

	- Local app preferences
	- Language
	- Design
	- Orientation
	- Remember window size and position
	- Log

	- Log Level
	- Delete log files
	- Share

	- Demo mode
	- Software update information
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“Resources” submenu
Settings → Configuration → Resources
The project planner can use the “Resources” menu to view the project size of the visualisation project and 
how much internal main memory it occupies in the KNX Smart Panel 8. The monitor also visualises the 
number of elements created, the internally linked data points, the ETS communication objects created (group 
objects) as well as the number of logics used, users created, schedules and sequences used.

Fig. 44: Smart Panel Designer – “Resources” submenu



Page 43 of 127SP 008 1U

Configuration

“Design” submenu
Settings → Configuration → Visualisation → Design
Date and time: 
The date and time can be shown or hidden within the top status and navigation bar using the “Design” menu 
item. Both are shown as standard. The temperature values for the indoor and outdoor temperature can also 
be activated/deactivated. For each, a communication object is created in the project file for later linking within 
the ETS, provided that the display was activated.
Single room mode: 
Activating/deactivating Single room mode dissolves the room structure and all the rooms and/or functions are 
combined in one room. Single room mode is deactivated as standard.
IMPORTANT: 
After Single room mode is activated, the created central functions disappear! 

Fig. 45: Smart Panel Designer – “Design” submenu

The following settings can be made:
	- Show date/time display
	- Outdoor temperature
	- Indoor temperature
	- Single room

•	 Confirm the settings with a checkmark. 
Settings for the design are applied.
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“KNX drivers” submenu
Settings → Configuration → Drivers → KNX → Twisted Pair
The “KNX drivers” submenu in the Smart Panel Designer can be used to configure the status query of the 
KNX bus (Twisted Pair) by the KNX Smart Panel 8. This later defines the start-up or initialisation behaviour 
of the device or the JUNG Smart Vision application. The device then reads out all available KNX objects 
sequentially during initialisation, provided the corresponding flags of the KNX subscribers have been set. 
The chosen settings are transferred to the Smart Panel after exporting the Designer project file *ksp and re-
programming via the ETS.

Fig. 46: Smart Panel Designer – “KNX driver” submenu

•	 Activate reading of the status at start-up with the toggle switch. 
The status of the KNX subscribers devices is requested when the device is started.

•	 Optional: Enter the interval for reading the status in milliseconds.
•	 Confirm the settings with a checkmark. 

Settings for KNX drivers are applied.
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“Internal variables” submenu
Settings → Configuration → Internal variables
From firmware version R4.9, the data points within an element can be changed and linked to internal 
variables (see “Changing attribute of an element” on page 29). 
Internal variables can be created, edited or deleted within the overview via the “Internal variables” submenu.

	i Internal variables are always linked via the “attribute” on the desired element!

Fig. 47: Smart Panel Designer – “Internal variables” submenu

•	 Select existing internal variables for editing or deletion. 
New variables can be added using the plus sign. 
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“Rules” submenu
Settings → Configuration → Rules
The KNX Smart Panel Designer possesses an internal logical editor, using which “If-Then-Else” instructions 
can be implemented for the JUNG Smart Vision app and later loaded into the device. New logic operations 
can be created using the plus icon. Existing logic operations can be searched for and edited using the 
magnifying glass icon.
Additional triggers (“If”) can be added using the small plus icon. Logic operations can be deleted again 
through a long press or by right-clicking the name within the list view. 

Fig. 48: Smart Panel Designer – “Rules” submenu

•	 Add a new rule using the Plus icon. 
The “New rule” submenu is displayed.
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“New rule” submenu
Settings → Configuration → Rules → New rule

Fig. 49: Smart Panel Designer – “New rule” submenu

•	 Enter the name for the rule.
•	 Select the logic operation type for the rule.
•	 Define the “If-Then-Else” instructions for the rule.
•	 Add optional “AND”/”OR” instructions using the small plus icon.
•	 Confirm the settings with a checkmark. 

Settings for the rule are applied.
	i From firmware version R4.9, logics can also be combined with internal variables!

Attention: 
An input object (condition) of a logic may not be used in the output of the same logic (loop)!
Logic operation types

Type Explanation
On demand Logic is triggered by a higher-level instance, for example.
Trigger Logic operation is evaluated on each new telegram in conjunction with a used 

data point.
On a value change Logic operation is only evaluated when the value of a used data point has 

changed effectively.

Note: 
With the “On demand” logic type, the trigger for recalculating a logic is triggered by the system, regardless of 
whether the values of the logic itself or the group objects have changed. The operation is only executed if the 
command to calculate was explicitly triggered for this logic by the higher-level instance. The system allows a 
logic (B) to be recalculated from a logic (A). The recalculation takes place once. The signal for the trigger can 
also be sent indirectly via a schedule or sequence.
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Example:

Fig. 50: Smart Panel Designer – “New rule” example

“Messages” submenu
Settings → Configuration → Messages
The software allows the creation and output of messages on the device.
If messages are to be issued in the case of a certain event, they must be created and linked by means of a 
logic via the internal logic editor. 
Description see page 47

Fig. 51: Smart Panel Designer – “Messages” submenu

•	 Activate messages with the toggle switch.
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“Messaging signal length” submenu
Settings → Configuration → Messages → Messaging signal length

Fig. 52: Smart Panel Designer – “Messaging signal length” submenu

Length Explanation
Endless An acoustic signal tone is output until the user has confirmed the message on the 

display as "read" via the message window.
Short An acoustic signal tone is output once for approx. 4 seconds. 
Medium An acoustic signal tone is output once for approx. 8 seconds. 
Long An acoustic signal tone is output once for approx. 16 seconds.

•	 Select the length for the output of the messaging signal. 
Settings for the messages are applied.
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“New message” submenu
Settings → Configuration → Messages → Messages
New messages are created using the plus icon. Existing messages can be searched for and edited using the 
magnifying glass icon. Messages can be deleted again through a long press or by right-clicking the name of 
the message within the list view. Each message can be given an additional message using the text box. In 
addition, a pop-up on the display and a signal tone can be output.

Fig. 53: Smart Panel Designer – “New message” submenu

•	 Add a new message using the Plus icon. 
The “Create new message” submenu is displayed.
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“Create new message” submenu
Settings → Configuration → Messages → Messages → New messages

Fig. 54: Smart Panel Designer – “Create new message” submenu

•	 Enter the name for the message.
•	 Select the type of message.
•	 Enter the message.
•	 Optionally, activate the pop-up, acoustic signalling and push notifications parameters. 
Requirement for push notifications: Cloud connection on the device and on the client (smartphone, tablet) 
is available. 
Description see page 84

•	 Optionally add e-mail recipients. 
Precondition: 
E-mail recipients have already been created. 
Description see page 54

•	 Confirm the settings with a checkmark. 
Settings for the messages are applied.

Message types
The types Info, Warning and Alarm stand for the corresponding levels of importance in ascending order. 
Each value is linked to a different acoustic signal tone, which can be played back as required. Messages can 
be integrated into logic operations.

Type Explanation
Info Lowest level
Warning Medium level
Alarm Highest level
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General information on messages
In general, there are two types of message:
	- System-wide messages, with which the system provides warnings or suggestions. These messages are 
generated independently by the system and are also generated when the messages in the menu are 
deactivated.

	- Messages on the User level, which appear during user-defined events. This type of messaging can be 
activated or deactivated via the menu. In consequence, the icon in the top bar is also shown or hidden.

Notifications on the user level can be combined with a signal tone, output using a pop-up window and linked 
to an e-mail notification. A push notification can also be sent to a paired smartphone / tablet (requires an 
active cloud connection). After triggering the message then appears in the message window of the JUNG 
Smart Vision app.

Fig. 55: Smart Panel Designer – Message window
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“E-mail recipient” submenu
Settings → Configuration → Messages → E-mail recipient
If users are to receive an e-mail notification from KNX Smart Panel 8 in the event of messages/events, these 
must first be created and configured within the software. Subsequently, the e-mail recipients must be linked 
to the respective message. 
Description see page 51
IMPORTANT: 
An SMTP server must be configured in the software for subsequent e-mailing! 
Description see page 55

Fig. 56: Smart Panel Designer – “E-mail recipient” submenu

•	 Add a new E-mail recipient using the Plus icon. 
The “E-mail recipient” submenu is displayed.

	i Recipients already in the list can be edited by long pressing or right clicking on the entry.
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“Create new e-mail recipient” submenu

Fig. 57: Smart Panel Designer – “Create new e-mail recipient” submenu

•	 Enter the name or description of the recipient.
•	 Enter the e-mail address of the recipient.
•	 Optionally set e-mail recipient as default recipient for messages.
•	 Optionally inform e-mail recipient of system messages by e-mail as well.
•	 Confirm the settings with a checkmark. 

Settings for the e-mail recipient are applied.
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“SMTP server” submenu
Settings → Configuration → Messages → SMTP server
In order to be able to send an e-mail notification from KNX Smart Panel 8 or JUNG Smart Vision in case 
of events, a functioning SMTP server must be configured in the software. For notification via e-mail, e-mail 
recipients must also be created and linked to the respective message/logic operation. 
Description see page 51 to page 54

Fig. 58: Smart Panel Designer – “SMTP server” submenu

•	 Enter the address of the SMTP server.
•	 Select connection type for the encryption
•	 Enter the address of the port used.
•	 Optionally select authentication mode. 

When selecting “Login”, also enter the user name and password of the e-mail account (provider). 
IMPORTANT: 
Depending on the e-mail provider (service), the permissions for sending via SMTP must first be set! The 
setup of the mailbox, port and encryption protocol may vary depending on the provider. Please contact the 
respective provider for more information.

•	 Optionally check settings for SMTP server with the “Test” button. 
If the configuration is successful/unsuccessful, a message appears via the message window.

•	 Confirm the settings with a checkmark. 
Settings for SMTP server are applied.

	i The configuration of the SMTP server can also be carried out on the Smart Panel and changed 
subsequently if required. To do this, log in to the Smart Vision app as a user/administrator and call up the 
submenu under “Settings → Configuration → Messages → SMTP server”.
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“User management” submenu
Settings → Configuration → User management
As standard, there are two access levels within the software. On the one hand, there is the Administrator 
level with the standard PIN code 74269, and also the User level, which can operate the visualisation without 
PIN entry.
All user access with a PIN code is terminated automatically after a standard timeout of 15 minutes. The work 
session times out after 15 minutes without an interaction with the device or software. The cog symbol in the 
top centre of the screen becomes transparent again and there is an automatic change to the user level. 
Temporary access rights through other users with higher-level rights (e.g. to view contents of a blocked room 
or to trigger certain functions) are permitted through the PIN entry of the appropriate user. These rights are 
terminated again after 10 seconds without an interaction (user is logged out).
The rights of the Administrator remain unchanged: They can be neither modified nor deleted. Only the PIN 
code can and should be changed (min. 5, max. 8 digits). 

	i From firmware version R4.11 onwards, there is also an “MQTT” user for managing the device’s integrated 
MQTT interface. The MQTT interface can only be enabled or disabled via Smart Panel Designer version 
1.5.5 or later and requires a new ETS download (see “ETS and DCA” on page 78).

Fig. 59: Smart Panel Designer – “User management” submenu

•	 Add a new user using the Plus icon. 
The “New user” submenu is displayed.
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“New user” submenu
Settings → Configuration → User management → User → New user
All the users are displayed within the list view.
Pressing the plus icon causes the form for a new user to appear. Then, a name can be entered for the user, 
along with a corresponding PIN code. The PIN code must consist of at least four and at most eight digits.
The corresponding user rights are then selected/deselected under “Permissions”. User rights can also be set 
via the permission matrix.
All the users then appear in the list view within the user management under “Users” and can be edited and 
deleted again (with the exception of Administrator/Standard) by a “long press” or “right click” on the name 
within the list view.

Fig. 60: Smart Panel Designer – “New user” submenu

User rights
The Administrator can define and manage new users through the specification of names, PIN code and 
appropriate user rights. User rights are determined using an permission matrix. The following basic rights are 
available for configuration:

Type Explanation
Display Display rooms and elements with corresponding values
Operation Operate elements (change values)
Time planning Manage time planning for elements (add, edit, delete)
Sequences Manage sequences (add, edit, delete)
Presence simulation Presence simulation, control playback and recording
User settings Resort tiles (only KNX Smart Panel Designer) and make additional settings on 

the Smart Panel, e.g.:
Access to App submenu (Smart Panel)
Access to Devices submenu (mobile devices)
Access to Couple submenu (Smart Panel)

•	 Enter the name of the user.
•	 Enter the PIN code and repeat it.
•	 Activate or deactivate optional permissions, such as time planning.
•	 Confirm the settings with a checkmark. 

Settings for the users are applied.
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“MQTT” submenu
Settings → Configuration → User Management → Users → MQTT
From firmware version R4.11 onwards, the KNX Smart Panel 8 offers the option of accessing the internal 
KNX visualisation on the device, i.e. JUNG Smart Vision, via external systems using the MQTT protocol.
This means that the JUNG SIP client can, for example, access specific elements and functions of the KNX 
Smart Panel 8 and use it to trigger KNX telegrams. In this configuration, the device acts as an MQTT server. 
Further details regarding MQTT will not be covered here.
Appropriate programming knowledge is a requirement.
To use and access the MQTT interface, the “MQTT” user must be activated in the project. This can only be 
done via the Smart Panel Designer from version 1.5.5 onwards. By default, the
“MQTT” is deactivated and external access to JUNG Smart Vision is not possible.
The MQTT configuration is opened by long-pressing or right-clicking on the “MQTT” entry within user 
management.

Fig. 61: Smart Panel Designer – Configuration of the MQTT interface

•	 Enable or disable the MQTT interface using the toggle switch.
•	 In the second step, change the access rights for MQTT users if necessary.
•	 Confirm settings by clicking the tick icon. 

Settings for MQTT users are applied.

The MQTT authentication data (username / password) is generated uniquely, i.e. project-specifically, and 
stored securely within the project file (*.ksp). Changes to the configuration of the MQTT interface therefore 
always require re-programming in ETS (see “ETS and DCA” on page 78).

	i For security reasons, MQTT access is only possible locally (i.e. not via the cloud). 
The security risk associated with activating MQTT access is therefore low. Nevertheless, security-relevant 
elements for external access should not be activated and must be explicitly denied.
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The permissions for (external) access – i.e. to the MQTT user – can be modified per requirement. Access 
to the device (indication = read; operation = write) is initially global, i.e. it applies to all controllable elements 
(KNX functions) of JUNG Smart Vision.

Fig. 62: Smart Panel Designer – MQTT interface permissions

•	 Configure (global) write and read permissions for the MQTT user.
•	 Confirm settings with the tick symbol. 

Settings for MQTT users are applied.

	i If only individual elements (KNX functions) are to be addressed externally via MQTT, the corresponding 
default permissions on the element must be overridden!

To access a specific element of JUNG Smart Vision via MQTT, you will need the relevant element ID. The 
relevant element ID can be found in the menu or in the properties of the respective element (KNX function) 
within the project, i.e. in the Smart Panel Designer.

Fig. 63: Smart Panel Designer – Element ID for external MQTT access
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“Permission matrix” submenu
Settings → Configuration → User management → Permission matrix
Permissions for individual users can also be configured simply using the permission matrix. The desired 
permission can be defined for each additionally created user.
IMPORTANT: 
Some of the basic permissions have clear dependencies. To operate something (Operation), for example, 
the user must be able to see it (Display). For this reason, in this example, the “Display” right is shown semi-
transparently and cannot be deactivated without deactivating the “Operation” right.

Fig. 64: Smart Panel Designer – “Permission matrix” submenu

Notes: 
The permissions “Display” and “User settings” have no dependencies. “Operation” and “Presence simulation” 
are dependent on the “Display” right. The permissions must be activated in advance!
The “Time planning” and “Sequences” permissions are both dependent on the “Operation” permission. 
They can only be activated when the “Operation” and “Display” permissions are activated beforehand. 
For this reason, the operation and display rights cannot be denied to a user, to whom “Time planning” and 
“Sequences” (or both) are assigned.

Colour Explanation
Green Assigned permission
Red Denied permission
Semi-transparent  
Green/red

Permission cannot currently be changed

•	 Assign or deny permissions for users.
•	 Confirm the settings with a checkmark. 

Settings for the users are applied.
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“Plugins” submenu
Settings → Configuration → Plugins
The “Plugins” menu can be used for optional configuration of additional (KNX) special functions for the 
visualisation project. Some of these functions impact the KNX bus directly and, after activation, make 
additional communication objects available within the ETS.

Fig. 65: Smart Panel Designer – “Plugins” submenu
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“Astronomical clock” submenu
Settings → Configuration → Plugins → Astronomical clock
The astronomical clock can, if necessary, show not just useful information on the display. The data for 
sunrise and sunset can, for example, be taken into account in time planning as an alternative to fixed times. 
The geographic data (latitude / longitude) are then entered in the input box. After activation, the function 
appears as a separate menu item, both in the software and also within the app on the device.

Fig. 66: Smart Panel Designer – “Astronomical clock” submenu

•	 Activate the astronomical clock with the toggle switch.
•	 Confirm the settings with a checkmark. 

Settings for the astronomical clock are applied.
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“Synchronise date/time” submenu
Settings → Configuration → Plugins → Date/time synchronisation
With this function, the current data and time of the device are written to the KNX bus as the date and time 
data source, as necessary. A local network (LAN) or an external time server is required for reliable outputs.
Alternatively, the synchronisation can also come from the KNX Bus. The Smart Panel or JUNG Smart Vision 
then obtains the time and date from the bus.

Fig. 67: Smart Panel Designer – “Synchronise date/time” submenu

•	 Activate Synchronise date/time with the toggle switch.
•	 Select Synchronisation mode.
•	 As an option, enter the time interval for synchronisation in minutes.
•	 As an option, enter the date interval for synchronisation in minutes.
•	 Confirm the settings with a checkmark. 
The settings for the Date/time synchronisation are applied.
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“Presence simulation” submenu
Settings → Configuration → Plugins → Presence simulation
With the presence simulation, defined data points are recorded within the system during normal use. 
Recorded actions are then simulated or played back when the user is not at home. The commands 
transmitted via the KNX Bus are recorded together with a time stamp. If necessary, there is a switch-over 
to the playback mode of the previous week, in order to simulate presence. In addition, two Start/Stop 
communication objects and the status of the later link are generated within the ETS. 

The following elements can be recorded and played back:
	- On/off elements (switch)
	- Dimmer
	- Blinds
	- RGB(W) elements
	- Personalised slider

The presence simulation works in two modes:
	- Record: Records the defined data in a separate database
	- Playback: Playback of recorded data in chronological order

The user can control the switchover between recording and playback themselves. If necessary, using the 
button provided in the user interface for the running time or based on a KNX data point (communication 
object).
The binary values are “0” for Record and “1” for Playback (Description see page 125).

IMPORTANT: 
The configuration (Playback, Record and Edit) of the presence simulation cannot be performed in the Smart 
Panel Designer. 
Only the preparations for this can be performed in the Smart Panel Designer. 
The configuration must be performed in the “Jung Smart Vision” app. 
Description see page 88
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Activating the presence simulation

Fig. 68: Smart Panel Designer – Activating the presence simulation

•	 Activate the presence simulation with the toggle switch.
•	 Confirm the settings with a checkmark. 

Settings for the presence simulation are applied. 
The “Presence simulation” submenu is displayed in the settings of the appropriate element.

Adding elements to a presence simulation
Functions and elements are connected to or included in the presence simulation singly, in order to be able 
to change over between recording and playback later on. For this, each individual element or each function, 
which is to belong to the presence simulation, must be explicitly activated/deactivated. As soon as the plug-in 
for the presence simulation has been activated, a corresponding entry on the presence simulation appears in 
each element.
Then, in the “Presence simulation” submenu, it is possible to define within the element which function is to be 
taken into account during recording/playback. The entries appear in element-specific form in a list.
After the selection of the appropriate function, it is necessary to configure whether the function is recorded 
and/or played back during operation.
As soon as the selected elements have all been selected and configured, the settings made are 
automatically transferred to the project file (*.ksp) for later ETS programming.
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“Presence simulation” submenu

Fig. 69: Smart Panel Designer – Adding elements to a presence simulation

•	 Select the “Presence simulation” submenu in the settings of the appropriate element. 
The list of elements for the presence simulation is displayed.

List of elements for the presence simulation

Fig. 70: Smart Panel Designer – List of elements for a presence simulation

•	 Select the element (function) for the presence simulation from the list. 
Recording and playback of the element is displayed.
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Recording and playback of the element for presence simulation

Fig. 71: Smart Panel Designer – Recording and playback of the element for presence simulation

•	 Activate recording and playback of the element for presence simulation. 
The configuration (Playback, Record and Edit) of the presence simulation cannot be performed in the 
“Jung Smart Vision” app. 
Description see page 88
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“Sequence push-button” submenu
Settings → Configuration → Plugins → Sequence push-buttons
This function sets up a connection between physical buttons on the KNX bus and sequences created in 
a JUNG Smart Vision in such a way that, on pressing a button, the sequence assigned to this button is 
executed. 
Requirements for the function:
	- 1 byte (0-255) group address, the Listener, similar to that for the KNX scenes
	- One or more KNX buttons, which, on “pressing”, transmit a numerical value to the above address 
	- The function can be activated in the sequence parameters.
	- Optional for buttons equipped with RGB LEDs, a group address (which can also group together multiple 
LEDs on the ETS level) of type DPT 232 (3 bytes). 

IMPORTANT: 
The configuration (coupling with a physical push-button) of the sequence push-buttons cannot be performed 
in the Smart Panel Designer. 
Only the preparations for this can be performed in the Smart Panel Designer. 
The configuration must be performed in the “Jung Smart Vision” app. 
Description see page 95

Fig. 72: Smart Panel Designer – “Sequence push-button” submenu

•	 Activate the sequence push-button with the toggle switch.
•	 Select timeout as an option. 
The timeout is the time by which the coupling with a KNX button must be completed.

•	 Optionally, enter the LED RGB colour. 
The colour must be entered as a hexadecimal value. 
The prespecified value #FFFFFF corresponds to the colour “Standard White”.

•	 Confirm the settings with a checkmark. 
Settings for the sequence push-button are applied.
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Activating the sequence push-button for an element

Fig. 73: Smart Panel Designer – Activating the sequence push-button for an element

•	 Select the “Parameters” menu in the settings of the appropriate sequence.
•	 Activate the sequence push-button with the toggle switch.
•	 Confirm the settings with a checkmark. 
Settings for the sequence push-button are applied. 
The configuration (coupling with a physical push-button) of the sequence push-buttons must be performed 
in the “Jung Smart Vision” app. 
Description see page 95
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“Time plan overview” submenu
Settings → Configuration → Plugins → Time plan overview
The time plan overview can be activated via the “Plugins” submenu. All created time plans can then be 
accessed and edited via the “Plugins” icon within the navigation bar.
IMPORTANT: 
Elements that are to be included in a time plan must be explicitly activated for this purpose as described 
above! 
Description see “Configure time planning for an element” on page 35

Fig. 74: Smart Panel Designer – “Time plan overview” submenu

•	 Activate the time plan overview with the toggle switch.
•	 Confirm the settings with a checkmark. 

Settings for time plan overview are applied.
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Display time plan overview

Fig. 75: Smart Panel Designer – Display time plan overview

•	 Display the plugins using the plugin icon in the status and navigation bar.
•	 Display the time plan overview by left-clicking the tile. 
The time plan overview is displayed.

Activate time plan

Fig. 76: Smart Panel Designer – Activate time plan

•	 Activate or deactivate the time plan using the corresponding toggle.
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“Export/Import” submenu
Settings → Configuration → Export/Import
Here, the project itself is managed. Exporting corresponds to saving the project in a *.ksp file. Importing 
corresponds to downloading a saved project, in which the current project is replaced. 
Resetting restores the project configuration to the factory setting (reset), i.e. all the changes are deleted and 
a new project can be created.
Export: Export visualisation project in the *.ksp file format
Import: Import visualisation project in the *.ksp file format
Reset: Delete the visualisation project and reset data
NOTE: 
The *.ksp project file, including the visualisation, is imported into the ETS later on via the DCA, in order to 
program the KNX Smart Panel 8.

Fig. 77: Smart Panel Designer – “Export/Import” submenu

•	 Select Export, Import or Reset.
•	 Depending on the selection, select the folder for export, select the file for import or confirm reset. 

Settings for the Export, Import or Reset are applied.
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“Local App preferences” submenu
Settings → Local App preferences
The “Local App preferences” menu contains further settings for the JUNG Smart Vision user interface. 

Fig. 78: Smart Panel Designer – “Local App preferences” submenu

Demo mode
The appropriate mode can be activated under “Demo Mode” for demonstration and presentation purposes. 
After activation, prefabricated rooms, including elements, are created and displayed automatically. 
An active Demo mode is displayed using the connection icon in the top status and navigation bar.

	i The actual project is maintained, i.e. as soon as the Demo mode is left, the software changes back to the 
current project.

IMPORTANT: 
When Demo mode is activated, the device cannot be programmed via the ETS (see “Export/Import” 
submenu on page 72). The Demo mode must be activated in advance. The same applies for the 
connection (coupling) with mobile devices (see “Pair” submenu on page 96). 
•	 Activate or deactivate Demo mode using the toggle.
•	 Confirm the settings with a checkmark. 

Settings for Demo mode are applied.

Software update information
Here, it possible to activate or deactivate messages regarding the software update. If active, it appears each 
time the program is launched.
•	 Activate or deactivate software update information.
•	 Confirm the settings with a checkmark. 

Settings for Software update information are applied.
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“Language” submenu
Settings → Local App preferences → Language
In the “Language” menu, the languages English, German, Spanish, Italian, French and Dutch are available 
for selection. The “Auto” option tries to select the language to be used later on by the operating system of the 
appropriate device. If this is not available, then English will be used as a fallback.

Fig. 79: Smart Panel Designer – “Language” submenu

•	 Select the language.
•	 Confirm the settings with a checkmark. 

Settings for the language are applied.
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“Design” submenu
Settings → Local App preferences → Design
In the “Design” menu, you can switch between a light and dark colour scheme for the display of the user 
interface.

Fig. 80: Smart Panel Designer – “Design” submenu

Light design Dark design

•	 Select the design.
•	 Confirm the settings with a checkmark. 

Settings for the design are applied.
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“Orientation” submenu
Settings → Local App preferences → Orientation
In the “Orientatio” menu, you can choose between horizontal and vertical alignment when projecting or 
creating the user interface. The orientation is oriented accordingly to the horizontal or vertical mounting of the 
KNX Smart Panel 8.

Fig. 81: Smart Panel Designer – “Orientation” submenu

Horizontal orientation Vertical orientation

•	 Confirm the settings with a checkmark. 
Settings for the orientation are applied.
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“Log” submenu
Settings → Local App preferences → Log
Application-specific logging can be activated and deactivated using “Log”. The logging applies only to the 
JUNG Smart Vision app or the software itself. As soon as logging has been activated, the two subitems “Log 
Level” and “Delete log files” can be operated. 

Fig. 82: Smart Panel Designer – “Log” submenu

The Log Level describes the system messages of the software to be written to the log file, from the lowest to 
the highest level. These messages are intended for support and analysis purposes and do not correspond to 
the messages on the user level.

Log Level Explanation
Error Messages with the Error level
Warning (standard) Messages with the Error and Warning levels
Info Messages with the Error, Warning and Info levels
Debug Messages with the Error, Warning, Info and Debug levels
Advanced Messages with the Error, Warning, Info and Debug levels and Advanced 

messages on the software

IMPORTANT: 
The Log function should only be activated as required and subject to agreement with the Customer Centre 
and deactivated again after solving the problem, as it will otherwise place a long-term burden on the storage 
medium through write operations.
•	 Activate or deactivate the logs using the toggle.
•	 Optionally, select Log Level.
•	 Confirm the settings with a checkmark. 

Settings for the logs are applied.

	i Using the “Share” menu, log files can be exported as a ZIP archive and saved locally.
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6.2	 ETS and DCA
To link communication objects for the rooms and elements of the later user interface, the *.ksp project file 
created earlier in the KNX Smart Panel Designer must be imported into the ETS. The *.ksp project file is 
imported via the DCA.
This must take place separately for each KNX Smart Panel 8 in the ETS project. 
Select the desired KNX Smart Panel 8 in the ETS project. Then, open the dialog for the project import in the 
“DCA” tab. Clicking “Import” opens the file selection. Then, you can select the *.ksp project file previously 
exported from the KNX Smart Panel Designer. 
The appropriate communication objects are now generated for the selected device. Switching to the 
“Communications objects” tab offers access to the communication objects created by the imported 
configuration. The communication objects can be linked to other KNX devices in the ETS project. 
IMPORTANT: 
The DCA Version 1.0.112.0 or higher is required!

6.2.1	 Downloading and installing
The DCA for the ETS must first be installed as an app. 
The DCA is available via the KNX Online Shop at https://my.knx.org/ .

Installation in the ETS takes place by adding it using the plus icon in the "Apps" 
menu, on the right-hand side in the lower Status bar.

As soon as the dialog for selecting the corresponding *.etsapp file appears, you can select the *etsapp file 
and thus install the DCA.
Then, it is necessary to restart the ETS.
The product data must then be imported. The product database can be downloaded via the online catalogue 
or at https://www.jung.de/ .
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6.2.2	 Activating ETS programming mode
As soon as all the links in the ETS have been set up, the device download can take place. Should this be the 
first download, then the ETS will request that Programming mode is activated on the device. 
As soon as Programming mode is active, an appropriate note appears in the bottom right-hand corner of 
the display of the device. This note covers any other applications. This makes it clear that the device is in 
Programming mode. 
The note is paired to the JUNG Smart Vision app and is only displayed when the JUNG Smart Vision app 
is running on the device. As soon as the device is in Programming mode, the download is performed in the 
ETS. After ending the ETS download, the Programming mode is automatically reset on the device. The 
JUNG Smart Vision app loads the newly-received configuration.

Fig. 83: JUNG Smart Vision – Activating ETS programming mode

Precondition: 
User is logged in as an Administrator.
•	 Activate ETS programming mode using the toggle switch in the “Settings” menu. 
ETS programming mode is shown in every menu. 
The ETS download to the device is started automatically. 
The ETS programming mode is stopped automatically after the download. 
ETS programming mode is hidden.
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6.2.3	 Deactivate “Overwrite sequences and time planning”
You can change time planning and sequences can be directly on the device.
The DCA offers the option of not writing user-specific data for “Sequences” and “Time planning” to the device 
during the download. For this, there is an option in the DCA, directly under the “Export” button. 

Fig. 84: ETS and DCA - “Overwrite sequences and time planning”

IMPORTANT: 
If the configuration is changed completely but the time planning and sequences are not written to the device 
with the remainder of the configuration, it is possible that the existing data on time planning/scenarios on the 
device do not agree with the remaining configuration, leading to error messages! 

6.2.4	 Exporting the configuration from the ETA via the DCA
The data transferred to the ETS is saved in the appropriate project in the ETS database. If necessary, a 
configuration can be exported from the ETS and imported into the KNX Smart Panel Designer for further 
processing. For this, simply select the desired KNX Smart Panel 8 in the ETS project and click “Export” in 
the DCA. In so doing, a *.ksp file is generated, which can then be imported in the KNX Smart Panel Designer 
under “Configuration → Export/Import → Import”. 
The export exports additional data to the device, such as the physical address and the project name.

6.2.5	 Export configuration without DCA and ETS from the device
It is possible to obtain the entire configuration of a device directly on the device, without the ETS. To do 
this, open the side menu of the JUNG Smart Vision app on the device using the cog icon, log in with the 
Administrator PIN (74269) and save a corresponding *.ksp file to a desired memory slot (e.g. USB stick on 
the rear side) under “Configuration → Export”.
Then, import the *.ksp file into the KNX Smart Panel Design, where it can be edited. All the data regarding 
the time planning and scenarios changed by the user are also copied. This can be directly processed further 
in the KNX Smart Panel Design and later overwritten on the ETS download to the device.
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6.3	 “JUNG Smart Vision” app – Advanced settings
After the visualisation project has been programmed to the device, additional settings are available for the 
JUNG Smart Vision app. 

Overview of the menu structure

	- Configuration
	- Resources
	- Drivers
	- Messages

	- SMTP server
	- MQTT
	- Cloud
	- Export
	- System

	- Update

	- Pair
	- Clients

	- Local App preferences
	- Design
	- Autostart
	- Log
	- Demo mode
	- Software update notice

6.3.1	 Configure advanced settings
“Configuration” submenu
Settings → Configuration

Fig. 85: JUNG Smart Vision – “Configuration” submenu
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“Resources” submenu
Settings → Configuration → Resources

Fig. 86: JUNG Smart Vision – “Resources” submenu

The “Resources” menu corresponds to the “Resources” menu in the Smart Panel Designer.
Description see page 42

“Drivers” submenu
Settings → Configuration → Drivers
The “Drivers” menu provides information on the current status of the KNX Twisted Pair (TP) connection 
between the device and the bus. This function is useful when trouble-shooting.

Fig. 87: JUNG Smart Vision – “Drivers” submenu
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“SMTP server” submenu
Settings → Configuration → Messages → SMTP server

Fig. 88: JUNG Smart Vision – “SMTP server” submenu

The “SMTP server” menu corresponds to the “SMTP server” menu in the Smart Panel Designer. 
Description see page 55

“MQTT” submenu
Settings → Configuration → MQTT

Displays the current MQTT configuration on the device. Changes can only be made via the Smart Panel 
Designer! Description see page 58
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“Cloud” submenu
Settings → Configuration → Cloud
The “Cloud” submenu is used to set up the cloud service (remote access) on the KNX Smart Panel 8. 
Remote access is exclusively via the JUNG Smart Vision app for smartphones and tablets.
For setting up a mobile device (client), see page 99

Fig. 89: JUNG Smart Vision – “Cloud” submenu

Requirements for remote access
	- myJUNG account
	- Remote access licence (ref. no.: SP-REMOTE-L)

	i The licence can be obtained via the online catalogue.
•	 Enable cloud service with the toggle switch.
•	 Select “myJUNG login”. 

The registration page opens.
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Fig. 90: JUNG Smart Vision – “Cloud myJUNG login” submenu

•	 Enter the e-mail address and password.
•	 Confirm the entry with “Continue”. 

Access authorization opens.

Fig. 91: JUNG Smart Vision – “Cloud myJUNG access authorization” submenu

•	 Confirm access with “Authorize”. 
Access authorization is closed. 
The “Cloud” submenu is displayed again.
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Fig. 92: JUNG Smart Vision – “Cloud” submenu

A successful myJUNG login is displayed with “OK”.
The KNX Smart Panel 8 is now set up for using cloud services (remote access).
•	 Confirm the settings with a checkmark. 

Settings are applied.

IMPORTANT: 
Each entry or change of the cloud services on the KNX Smart Panel 8 must be confirmed with a checkmark. 
Remote access can be enabled and disabled via the toggle switch. However, the remote access licence 
remains paired to the device. The pairing can only be removed in the myJUNG account under remote 
management!

Fig. 93: JUNG Smart Vision – “Cloud enabled” submenu

Successful enabling of the cloud services is displayed on the device.
•	 Confirm notification with “OK”.
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Fig. 94: JUNG Smart Vision – Connection status

The cloud connection icon is displayed in the status bar.
The KNX Smart Panel 8 is now prepared for remote access via the JUNG Smart Vision app on a smartphone 
or tablet.
For setting up a mobile device (client), see page 99

“Export” submenu
Settings → Configuration → Export

Fig. 95: JUNG Smart Vision – “Export” submenu

The “Export” menu corresponds to the “Export/Import” menu in the Smart Panel Designer.
Description see page 72
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6.3.2	 Configuring the presence simulation (play back, record and edit)
IMPORTANT: 
The preparations for the configuration of the presence simulation cannot be performed in the “Jung Smart 
Vision” app. 
The preparations must be made in the Smart Panel Designer. 
Description see page 64 ff
Preconditions: 
The presence simulation is activated.  
Elements were added to the presence simulation.  
Recording and playback were activated for elements. 

Record and playback mode of the presence simulation

Fig. 96: JUNG Smart Vision – Record and playback mode of the presence simulation

As soon as recording is active, a pulsing red dot appears in the top left corner, above the information for the 
date and time. If the push-button on the user interface is pressed, playback mode starts. The icon in the top 
corner also changes to Playback mode. The icon within the push-button switches to Record mode.

Icon Name Explanation
Playback Playback mode of the presence simulation is activated

Recording Record mode of the presence simulation is activated

Note: 
The presence simulation is always in record mode after being activated.
During playback, the last week of recorded commands is played back, if available. If a day is not found, then 
the system jumps to the previous day until it finds a day actually containing commands. This means that the 
recording of a single day can also be used and played back each day.
The current mode (record/playback) is permanently saved in the database and, after a restart of the device, 
the saved most is applied directly after booting.
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Display presence simulation

Fig. 97: JUNG Smart Vision – Display presence simulation

•	 Display the plugins using the plugin icon in the status and navigation bar.
•	 Display the presence simulation by left-clicking the tile. 
The presence simulation is displayed.

Display settings of the presence simulation

Fig. 98: JUNG Smart Vision – Detail view of the presence simulation

•	 Select the settings of the presence simulation using the cog icon. 
The settings of the presence simulation are displayed.
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Display playback of the presence simulation

Fig. 99: JUNG Smart Vision – Settings of the presence simulation

•	 Select the playback of the presence simulation. 
The playback of the presence simulation is displayed.

Activate playback of the presence simulation
In the “Playback” menu, it is possible to activate/deactivate individual functions of the presence simulation 
for playback. These are then removed accordingly from the playback. The settings can be made within the 
JUNG Smart Vision app on the Smart Panel.

Fig. 100: JUNG Smart Vision – Playback of the presence simulation

•	 Activate or deactivate elements for the playback of the presence simulation with the toggle switch.
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Recording of the presence simulation
The “Record” menu lists all previous, complete recordings of the presence simulation. Commands and/or 
actions can be added, edited or removed for hours or days.
The “Trash can” icon deletes all the recordings. Individual recordings and commands are deleted using the 
appropriate minus icon. Jumping to the appropriate day switches to the next lowest level: Day → Hour → 
Action
New actions can be added and edited manually using the plus icon. However, only the functions previously 
enabled in the KNX Smart Panel Designer can be selected for the presence simulation.

Fig. 101: JUNG Smart Vision – Recording the presence simulation

•	 Add a new action to the recording of the presence simulation using the plus icon. 
The new action for recording the presence simulation is displayed.
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New action for recording the presence simulation

Fig. 102: JUNG Smart Vision – New action for recording the presence simulation

•	 Select the day and time of the new action.
•	 Enter the name for the new action and select the type of new action.
•	 Confirm the settings with a checkmark. 

Settings for the new action for the presence simulation are applied.
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Data structure of the recording
The recorded data is structured into periods:
	- Week

	- Weekday
	- Section start 
Time stamp (hour-minute) - Action details (data point, value) 
Time stamp (hour-minute) - Action details (data point, value) 
...

	- Section end
	- Section start 
…

	- Section end
	- ...

The sections are necessary to recognise whether there are valid recordings in this time period or not, and to 
react appropriately.
Each section is marked with a start and end mark. If one or other of these is missing, it means that the 
section is invalid. The KNX Smart Panel 8 can be switched off during the entire section. For this reason, no 
recording was possible during this section.
A section must start and end correctly to be valid. If a section is considered invalid, then a fallback method is 
used.

Fig. 103: JUNG Smart Vision – Data structure of the recording
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Diagram of the data structure of the recording

Fig. 104: JUNG Smart Vision – Diagram of the data structure of the recording

Restrictions and limitation
	- Recording is limited to one week, assigned to weekdays. 
	- The time frame for a single period is 1 hour (recording).
	- The maximum number of data points permitted for recording is 30 (thirty). The number of recordable data 
points varies from element to element.

	- The maximum temporal resolution for recorded values of the same data points is 1 minute. If, during 
one minute, the same data point changes its value more than once, then the last received value will be 
recorded.

Recording cycle
Recording is always started at the start of the next time period (hh:00) after the switch to Record mode.
To trigger the swapping of temporarily recorded data, the started period must end (hh:59). Otherwise, the 
swap will not be carried out and the recorded data is lost.

Playback cycle
Playback starts immediately after switching to Playback mode, irrespective of the start of the next time 
period.
The internal of the above loop is 1 minute.

IMPORTANT: 
After each change to the data point level (changes in the ETS; re-import or additions), it is the responsibility 
of the system integrator to delete the current recording if the presence simulator is active and recording! This 
prevents playback from sending commands which may, for example, have changed their impact, because 
they have been assigned to a different KNX subscriber.
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6.3.3	 Configuring the sequence push-button (pairing with a physical push-button)
IMPORTANT: 
The preparations for the configuration of the sequence push-button cannot be performed in the “Jung Smart 
Vision” app. 
The preparations must be made in the Smart Panel Designer. 
Description see page 68 ff
Information on preparing the ETS: 
A specific value must be programmed in the ETS, which is transmitted to the address of the “Listener” 
(object) on pressing a button. 
The “Listener”, which now receives a value through the pressing of the button, records the combination of the 
received value and the currently opened sequence and saves it.
IMPORTANT: 
Two corresponding communication objects for the project import and generated for the linking of the 
sequence push-button within the ETS. 
Description see page 120

Fig. 105: JUNG Smart Vision – Configuring the sequence push-button

Preconditions: 
User is logged in as an Administrator. 
Values for the Listener (object) must be programmed in the ETS.
•	 In the detail view of the appropriate sequence, select the sequence push-button. 
The time for the pairing of the sequence push-button with a physical button starts. 
As orientation, one of more LEDs of the buttons light up.

•	 Press the button for pairing with a sequence push-button. 
The button must be pressed before the timer ends. 
The timer is preset to 120 seconds. 
The sequence is executed each time the button is pressed.
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6.3.4	 Pairing the Smart Panel with a mobile device (client)
Preconditions: 
User is logged in as an Administrator. 
The visualisation project is programmed into the device via ETS. 
The Smart Panel and mobile devices are in the same local network (Wi-Fi).
“Pair” submenu
Settings → Configuration → Pair
Besides the purely stand-alone system to the KNX controller, the KNX Smart Panel 8 also functions as a 
server for other mobile devices, in order to allow operation of the KNX visualisation via the JUNG Smart 
Vision app. The device can be connected quickly and simply with the smartphone or tablet. The precondition 
in the JUNG Smart Vision app on the appropriate mobile device. The app can be downloaded via the Google 
Play Store (Android) and Apple Store (iOS). 
IMPORTANT: 
From firmware version R4.7, remote access to the KNX Smart Panel 8 is possible via the JUNG Smart 
Vision app. A myJUNG account and remote access licence (ref. no. SP-REMOTE-L) are required for remote 
access. The licence can be obtained via the online catalogue.
IMPORTANT: 
To couple the KNX Smart Panel 8 with mobile devices, the devices must be in the same local network (Wi-
Fi).

Fig. 106: JUNG Smart Vision – “Pair” submenu

•	 Enter the device ID.
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“Clients” submenu
Settings → Configuration → Pair → Clients
New mobile devices can be created in the “Clients” menu. A maximum of 10 app users (clients) per 
installation can be connected to the device. New clients are created using the plus icon.
All the clients are displayed within the list view. In addition, the system shows whether the access for the 
appropriate client is currently activated or not. A “long press” on the client name within the list causes the 
option to appear for the deletion of the appropriate client.

Fig. 107: JUNG Smart Vision – “Clients” submenu

•	 Add a new client using the Plus icon. 
The “Add client” submenu is displayed.
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“Add client” submenu
Settings → Configuration → Pair → Add client

Fig. 108: JUNG Smart Vision – “Add client” submenu

•	 Enter the name for the client.
•	 Generate the pairing code. 
The pairing code is displayed as a QR and numeric code.

•	 Leave the menu open.
•	 Pair the mobile device (client) with the Smart Panel. 

Description see page 99 
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6.4	 “JUNG Smart Vision” app – Mobile device (client)
6.4.1	 Downloading and installing

The app can be downloaded via the Google Play Store (Android) and Apple Store (iOS). Then, the app can 
be installed on the mobile device (smartphone or tablet).

6.4.2	 Operation
The operation of the app on the mobile device corresponds to the operation of the app on the Smart Panel. 
Overviews of the app sections can be found at page 13 and at page 41.
Further basic operation principles can be found here:
Open settings 
Description see page 22
Log user in as Administrator 
Description see page 23 
The default Administrator password is: 74269

6.4.3	 Pairing the mobile device (client) with the Smart Panel
Setup of a new device
Settings → Devices → New device

          
Fig. 109: JUNG Smart Vision – Setup of a new device

Preconditions: 
User is logged in as an Administrator. 
The visualisation project is programmed into the device via ETS. 
The Smart Panel and mobile device are in the same local network (Wi-Fi). 
Pairing code was generated on the Smart Panel, description see page 96.
•	 Select “Devices” in the “Settings” menu. 
A list of already paired devices opens.

•	 Add a new device using the Plus icon. 
The “New device” submenu is displayed.

•	 Select “Address”. 
Available KNX Smart Panels are searched for automatically. 
The list of found devices is displayed.
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Fig. 110: JUNG Smart Vision – Setup of a new device

•	 Select the device for pairing from the list of the found devices. 
The address, name and serial number of the selected devices are applied to the “New device” menu. 
The “New device” menu is displayed.

	i If the searched for device is not displayed in the list, enter the IP address in the Search function and 
confirm it with the Search icon. Alternatively, press the Update icon via the Search function.

•	 Select “Start pairing”. 
“Enter pairing code” is displayed.

          
Fig. 111: JUNG Smart Vision – Setup of a new device

•	 Scan the QR code on the KNX Smart Panel 8. 
Alternatively, enter the digits of the pairing code via the keypad and confirm the entry with “OK”. 
Mobile device (client) is paired with the KNX Smart Panel 8. 
The paired device is applied to the “Settings” menu.
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6.4.4	 Adjusting settings for paired devices on the mobile device (client)
Editing or removing a paired device
Settings → Devices → Edit or delete device

          
Fig. 112: JUNG Smart Vision – Editing or removing a paired device

Preconditions: 
User is logged in as an Administrator. 
The visualisation project is programmed into the device via ETS. 
Mobile device and Smart Panel are paired, description see page 96.
•	 Select “Devices” in the “Settings” menu. 
A list of already paired devices opens.

•	 To edit or delete the paired device, press it for a longer period of time.  
The “Edit” and “Delete” buttons are displayed.
	i Briefly pressing the paired device displays the room overview (KNX visualisation) in the app. The settings 
must then be opened again.

Connection status between the mobile device (client) and the Smart Panel

Icon Explanation
Paired: Operation of the visualisation is possible

Device automatically connected on launching the app

Direct network connection via Wi-Fi available

Cloud connection (remote access) available

	i The local connection is standard for the JUNG Smart Vision app.
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Changing the connection mode (locally / cloud)
Settings → Devices → Edit device → Connection mode → Locally / Cloud

          
Fig. 113: JUNG Smart Vision – Changing the connection mode of a paired device

•	 Select “Edit” in the “Settings” submenu. 
The settings of the paired device are displayed.

•	 Select “Connection mode” in the settings of the paired device.
•	 Select “Locally” or “Cloud” as the connection mode.
•	 Confirm the settings with a checkmark.
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Removing a paired device
Settings → Devices → Delete device

          
Fig. 114: JUNG Smart Vision – Removing a paired device

•	 Select “Delete” in the “Settings” submenu. 
The device is removed from the list of paired devices. 
Operating the visualisation on the Smart Panel is no longer possible with the mobile device.
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Enabling push notifications
Settings → Devices → Edit device → Push notifications → Enable
Push notifications can be sent to a paired mobile device (client). A push notification is part of a message and 
must be enabled in the Smart Panel Designer.  
Description see “Messages” submenu on page 48
If messages are to be issued in the case of a certain event, they must be created and linked by means of a 
logic via the internal logic editor.
IMPORTANT: 
Push notifications require an active cloud connection!

          
Fig. 115: JUNG Smart Vision – Enabling push notifications

•	 Select “Edit” in the “Settings” submenu. 
The settings of the paired device are displayed.

•	 Select “Push notifications” in the settings of the paired device.
•	 Enable push notifications with the toggle switch.
•	 Confirm the settings with a checkmark.
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6.4.5	 Updating firmware via a mobile device (client)
Settings → Configuration → System → Update
The KNX Smart Panel 8 can also be updated via a mobile device (client) using the JUNG Smart Vision app 
as an alternative to the “System Update” application (see page 10).

          
Fig. 116: JUNG Smart Vision – Updating firmware via a mobile device (client)

Requirements: 
Internet connection is available on the KNX Smart Panel 8. 
Mobile device and Smart Panel are paired, description see page 96.
•	 Select “Configuration” in the “Settings” menu. 
“Configuration” submenu opens.

•	 Select “System” in the “Configuration” menu. 
“System” submenu opens.

•	 Select “Update” in the “System” menu. 
“Update” submenu opens.
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Settings → Configuration → System → Update → KNX Smart Panel 8 system update

     
Fig. 117: JUNG Smart Vision – Starting firmware update

•	 Select “KNX Smart Panel 8 system update” in the “Update” menu. 
“KNX Smart Panel 8 system update” opens.

•	 Select “update”. 
Firmware update is started. 
The update progress is displayed. 
Smart Panel is automatically restarted after a successful update.

IMPORTANT: 
Do not interrupt the power supply and internet connection during updating!
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7	 Communication objects
7.1	 Data point types

The following data point types (DPT) are currently supported by JUNG Smart Vision:

ID Length Function
DPT 1   1 bit Switch (on/off or up/down, etc.)
DPT 2   2 bit 1 control bit (0/1) and 1 switch bit (0/1)
DPT 5   1 byte (%) (0…100, 0…255 or 0…360°)
DPT 6   1 byte (%) (-128…127)
DPT 7   2 bytes (lux, mm, ms etc. 0...65535)
DPT 8   2 bytes (time difference, rotation, etc. -32768...32767)
DPT 9   2 bytes (float) Floating point values (-671088.64…670760.96)
DPT 10   3 bytes Time
DPT 11   3 bytes Date
DPT 12   4 bytes 0...4294967295
DPT 13   4 bytes -2147483648...2147483647
DPT 14   4 bytes 4-octet float value IEEE 754
DPT 16 14 byte Character string (max. 14 letters/symbols)
DPT 18   1 byte Scene control
DPT 19   8 bytes Time and date
DPT 20   1 byte 8 bit unsigned (e.g. HVAC mode)
DPT 232   3 bytes RGB
DPT 251   6 bytes RGBW

IMPORTANT: 
A maximum of 300 areas or elements can be created. 
A maximum of 1,000 communication objects can be linked.

7.2	 Elements and objects
On/off

Fig. 118: Elements and objects – On/off

This element applies to any switch allowing two possible states. Under Parameters, you can find icons 
including labelling for additional personalisation.

DPT Name Object function Length Data Type
1.001 On/Off Switching 1 bit switch
1.001 On/Off Status Switching feedback 1 bit switch
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Forced operation

Fig. 119: Elements and objects – Forced operation

	i This element or object is only available from firmware version R4.5.
This element supports KNX DPT 2, i.e. 2-bit group addresses that allow switching between automatic and 
manual control. It is a pure switching element and does not provide any feedback on the active On or Off 
status in the automatic status.

DPT Name Object function Length Data Type
2.001 Forced guidance Forced position 2 bit switch control
2.001 Forced guidance Status Forced position feedback 2 bit switch control

Dimmer

Fig. 120: Elements and objects – Dimmer

This element type does not provide any parameters.

DPT Name Object function Length Data Type
1.001 On/Off Switching 1 bit switch
1.001 On/Off Status Switching feedback 1 bit switch
5.001 Dimming Brightness value 1 byte percentage (0..100%)
5.001 Dimming Status Brightness value feedback 1 byte percentage (0..100%)
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Venetian blind up/down

Fig. 121: Elements and objects – Shutter up/down

This element type does not provide any parameters.

DPT Name Object function Length Data Type
1.008 Up/Down Long-time operation 1 bit up/down
1.008 Up/Down Status Long-time operation feedback 1 bit up/down
1.007 Up/Down step Short-time operation 1 bit step

Venetian blind, percentage

Fig. 122: Elements and objects – Shutter, percentage

This element type does not provide any parameters.

DPT Name Object function Length Data Type
1.008 Up/Down Long-time operation 1 bit up/down
1.008 Up/Down Status Long-time operation feedback 1 bit up/down
1.007 Up/Down step Short-time operation 1 bit step
5.001 Position Position of venetian blind 1 byte percentage (0..100%)
5.001 Position Status Venetian blind position feedback 1 byte percentage (0..100%)
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Venetian blind

Fig. 123: Elements and objects – Venetian blind

This element type has two parameters:
	- Venetian blind slider (activated/deactivated)
	- Slats slider (activated/deactivated)
It offers up to 6 functions, which must be linked to matching data points.
This is the most complete element type for the control of Venetian blind actuators.

DPT Name Object function Length Data Type
1.008 Up/Down Long-time operation 1 bit up/down
1.008 Up/Down Status Long-time operation feedback 1 bit up/down
1.007 Up/Down step Short-time operation 1 bit step
5.001 Position Position of venetian blind 1 byte percentage (0..100%)
5.001 Position Status Venetian blind position feedback 1 byte percentage (0..100%)
1.008 Inclination up/down Slat Long-time operation 1 bit up/down
1.008 Inclination up/down Status Slat Long-time operation feedback 1 bit up/down
1.007 Inclination up/down step Slat Short-time operation 1 bit step
5.001 Inclination Slat position 1 byte percentage (0..100%)
5.001 Inclination Status Slat position feedback 1 byte percentage (0..100%)
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RGB(W)

Fig. 124: Elements and objects – RGB(W)

	i This element or object is only available from firmware version R4.5.
The element provides for the following parameters: 
	- Data points for red, green and blue, and data point for switching on and off
	- Option: The colour white (for RGBW devices) and the dimmer can be activated or deactivated.
	- Option: Selection for HSV colour display possible
Element → Parameter → Colour data point → R-G-B-W (multiple data points)

DPT Name Object function Length Data Type
1.001 On/Off Switching 1 bit switch
1.001 On/Off Status Switching feedback 1 bit switch
5.001 
5.010 Colour red Dimming absolute R 1 byte percentage (0..100%)

counter pulses (0..255)
5.001 
5.010 Colour red Status Dimming absolute R feedback 1 byte percentage (0..100%)

counter pulses (0..255)
5.001 
5.010 Colour green Dimming absolute G 1 byte percentage (0..100%)

counter pulses (0..255)
5.001 
5.010 Colour green Status Dimming absolute G feedback 1 byte percentage (0..100%)

counter pulses (0..255)
5.001 
5.010 Colour blue Dimming absolute B 1 byte percentage (0..100%)

counter pulses (0..255)
5.001 
5.010 Colour blue Status Dimming absolute B feedback 1 byte percentage (0..100%)

counter pulses (0..255)
5.001 Dimming Brightness value 1 byte percentage (0..100%)
5.001 Dimming Status Brightness value feedback 1 byte percentage (0..100%)
5.001 Colour white Dimming absolute W 1 byte percentage (0..100%)
5.001 Colour white Status Dimming absolute W feedback 1 byte percentage (0..100%)
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Element → Parameter → Colour data point → RGB-W (multiple data points)

DPT Name Object function Length Data Type
1.001 On/Off Switching 1 bit switch
1.001 On/Off Status Switching feedback 1 bit switch
232.600 Colour RGB RGB absolut (3-Byte) 3 bytes RGB value 3x(0..255)
232.600 Colour RGB Status RGB absolut (3-Byte) feedback 3 bytes RGB value 3x(0..255)
5.001 Dimming Brightness value 1 byte percentage (0..100%)
5.001 Dimming Status Brightness value feedback 1 byte percentage (0..100%)
5.001 Colour white Dimming absolute W 1 byte percentage (0..100%)
5.001 Colour white Status Dimming absolute W feedback 1 byte percentage (0..100%)

Element → Parameter → Colour data point → RGBW (single data point)

DPT Name Object function Length Data Type
1.001 On/Off Switching 1 bit switch
1.001 On/Off Status Switching feedback 1 bit switch
251.600 Colour RGBW RGBW (6-Byte) 6 bytes RGB value 4x(0..255)
251.600 Colour RGBW Status RGBW (6-Byte) feedback 6 bytes RGB value 4x(0..255)
5.001 Dimming Brightness value 1 byte percentage (0..100%)
5.001 Dimming Status Brightness value feedback 1 byte percentage (0..100%)

Element → Parameter → Colour data point → H-S-V-W (multiple data points)

DPT Name Object function Length Data Type
1.001 On/Off Switching 1 bit switch
1.001 On/Off Status Switching feedback 1 bit switch
5.003 
5.010 Colour hue Colour hue (H) 1 byte angle (degrees)  

counter pulses (0..255)
5.003 
5.010 Colour hue Status Colour hue (H) feedback 1 byte angle (degrees)  

counter pulses (0..255)
5.001 
5.010 Colour saturation Saturation (S) 1 byte percentage (0..100%)

counter pulses (0..255)
5.001 
5.010 Colour saturation Status Saturation (S) feedback 1 byte percentage (0..100%)

counter pulses (0..255)
5.001 
5.010 Colour value Brightness (V) 1 byte percentage (0..100%)

counter pulses (0..255)
5.001 
5.010 Colour value Status Brightness (V) feedback 1 byte percentage (0..100%)

counter pulses (0..255)
5.001 Dimming Brightness value 1 byte percentage (0..100%)
5.001 Dimming Status Brightness value feedback 1 byte percentage (0..100%)
5.001 Colour white Dimming absolute W 1 byte percentage (0..100%)
5.001 Colour white Status Dimming absolute W feedback 1 byte percentage (0..100%)
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Element → Parameter → Colour data point → HSV-W (multiple data points)

DPT Name Object function Length Data Type
1.001 On/Off Switching 1 bit switch
1.001 On/Off Status Switching feedback 1 bit switch
232.600 Colour HSV HSV absolut (3-Byte) 3 bytes RGB value 3x(0..255)
232.600 Colour HSV Status HSV absolut (3-Byte) feedback 3 bytes RGB value 3x(0..255)
5.001 Dimming Brightness value 1 byte percentage (0..100%)
5.001 Dimming Status Brightness value feedback 1 byte percentage (0..100%)
5.001 Colour white Dimming absolute W 1 byte percentage (0..100%)
5.001 Colour white Status Dimming absolute W feedback 1 byte percentage (0..100%)

Element → Parameter → Colour data point → HSVW (single data point)

DPT Name Object function Length Data Type
1.001 On/Off Switching 1 bit switch
1.001 On/Off Status Switching feedback 1 bit switch
251.600 Colour HSVW HSVW (6-Byte) 6 bytes RGB value 4x(0..255)
251.600 Colour HSVW Status HSVW (6-Byte) feedback 6 bytes RGB value 4x(0..255)
5.001 Dimming Brightness value 1 byte percentage (0..100%)
5.001 Dimming Status Brightness value feedback 1 byte percentage (0..100%)

The RGB(W) element can store up to 10 colour settings (presets).
The respective preset can be called up via the corresponding button.

(1) coloured circular area
(2) grey ring, outside
(3) white ring, inside
(4) grey ring, inside

Set time
Selected preset
Percentage of white (0 – 100 %)
Percentage of the dimmer (0 – 100 %)

Plus sign
Minus sign
Pen symbol

Add preset
Delete preset
Edit preset

Tick symbol
Close symbol

Save changes to preset
Discard changes to preset

Important:
	- Presets with identical settings cannot be created!
	- If parameters of an RGB(W) element with saved presets are changed subsequently, data may be lost 
(dimmer values/white values). Reprogramming via ETS can overwrite presets that have already been 
created (data point type changes)!

4

1 2

3
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Tunable White

Fig. 125: Elements and objects – Tunable White

	i This element or object is only available from firmware version R4.5.
The Tunable White element is used to control lamps whose colour temperature (Kelvin) can be changed. 
The element provides for the following parameters:
	- Switch on/off
	- Option: Activate/deactivate dimmer
	- Min. colour temperature: value in Kelvin
	- Max. colour temperature: value in Kelvin
	- Colour temperature step size: distance or interval between two signs on scale
	- Colour temperature value step: largest or smallest possible value change

DPT Name Object function Length Data Type
1.001 On/Off Switching 1 bit switch
1.001 On/Off Status Switching feedback 1 bit switch
5.001 Dimming Brightness value 1 byte percentage (0..100%)
5.001 Dimming Status Brightness value feedback 1 byte percentage (0..100%)
7.600 Colour temperature Colour temperature (Kelvin) 2 bytes absolute colour temperature (K)
7.600 Colour temperature 

Status
Colour temperature (Kelvin) 
feedback

2 bytes absolute colour temperature (K)

The Tunable White element can store up to 10 colour settings (presets).
The respective preset can be called up via the corresponding button.
Presets are created, edited and removed in the same way as the RGB(W) element.

Important:
	- Presets with identical settings cannot be created!
	- If parameters of an Tunable White element with saved presets are changed subsequently, data may be 
lost (dimmer values/white values). Reprogramming via ETS can overwrite presets that have already been 
created (data point type changes)!
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Thermostat (satellite unit)
This element type is that with the broadest scope of function. The parameters include:

Mode (operating mode) 
 
 
 

None 
AUTO-COM-PRE-ECO-OFF  
COM-PRE-ECO-OFF 
COM-STBY-NIGHT-FROST 
ON-OFF

Activate operating mode bits Activate / Deactivate
Fan type 
 
 
 
 

None 
On / Off (only status) 
Off / Speed 1-3 (only status) 
Auto / [Man Off/On] 
Auto / [Man Off/Speed 1-3) 
Auto / Man

Heating/cooling function Heating and cooling 
Heating 
Cooling

Invert cooling/heating Activate / Deactivate
Activate setpoint Activate / Deactivate
Min. value setpoint Smallest value (lower limit)
Max. value setpoint Largest value (upper limit)
Common setpoint (for heating and 
cooling)

Activate / Deactivate

Activate heating/cooling status symbol Activate / Deactivate
Activate effective setpoint (indication) Activate / Deactivate
Setpoint slider Room view / Detailed view / Room and detailed view
Activate setpoint offset (shift) Activate / Deactivate
Offset step size Step size (setpoint shift in Kelvin)
Min. value offset Smallest value (setpoint shift in Kelvin) (lower limit)
Max. Value Offset Largest value (setpoint shift in Kelvin) (upper limit)
Offset data point type* DPT 6.010 -128 ..127 or  

DPT 9.002 2-byte floating point number
Setpoint offset slider Room view / Detailed view / Room and detailed view
Activate humidity display Activate / Deactivate
Dew point* Deactivated (standard)

Only visible if humidity display is activated:
	 Status indication only
	 Send on change
	 Send cyclically
	 Transmit on value change and cyclically
Use external dew point

Activate status symbol window Activate / Deactivate
Invert window status Activate / Deactivate
Activate status symbol presence Activate / Deactivate
Invert presence status Activate / Deactivate

* Only available from firmware version R4.10.
Note: 
Optionally, it is possible to activate individual operating mode bits (1-bit object incl. feedback) to switch over 
the operating mode. These are then available as communication objects within the ETS.
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Full expansion level, thermostat (satellite unit)

Fig. 126: Elements and objects – Thermostat

DPT Name Object function Length Data Type
9.001 Temperature Status Temperature 2 byte temperature (°C)
20.102 Operating mode Operating mode switchover 1 byte HVAC mode
20.102 Operating mode Status KNX status operating mode 1 byte HVAC mode
1.002 Operating mode COM Comfort mode 1 bit boolean
1.002 Operating mode COM 

Status
Comfort mode feedback 1 bit boolean

1.002 Operating mode STBY Standby mode 1 bit boolean
1.002 Operating mode STBY 

Status
Standby mode feedback 1 bit boolean

1.002 Operating mode NIGHT Night operation 1 bit boolean
1.002 Operating mode NIGHT 

Status
Night operation feedback 1 bit boolean

1.002 Operating mode FROST Frost / heat protection 1 bit boolean
1.002 Operating mode FROST 

Status
Frost / heat protection 
feedback

1 bit boolean

1.001 Fan on/off Fan on/off 1 bit switch
1.001 Fan on/off Status Fan on/off feedback 1 bit switch
5.100 Fan speed Fan level specification 1 byte fan stage (0 .. 255)
5.100 Fan speed Status Feedback for fan level 1 byte fan stage (0 .. 255)
1.001 Fan auto/man Specification, ventilation, 

automatic/manual
1 bit switch

1.001 Fan auto/man Status Feedback, ventilation, 
automatic/manual

1 bit switch

9.001 Setpoint Basic setpoint 2 byte temperature (°C)
9.001 Setpoint Status Basic setpoint feedback 2 byte temperature (°C)
1.001 Heating on/off status 

Status
Heating indication 1 bit switch

1.001 Cooling on/off status 
Status

Cooling indication 1 bit switch

9.001 Setpoint effective Status Set temperature 2 byte temperature (°C)
6.010 Setpoint offset Preset setpoint shifting 1 byte counter pulses 

(-128 .. 127)
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DPT Name Object function Length Data Type
9.002 Setpoint offset Setpoint adjustment 

specification
2 byte temperature difference (K)

6.010 Setpoint offset Status Current setpoint shifting 1 byte counter pulses 
(-128 .. 127)

9.002 Setpoint offset status Current setpoint adjustment 2 byte temperature difference (K)
1.001 Cooling/Heating switch Heating/cooling switchover 1 bit switch
1.001 Cooling/Heating switch 

Status
Heating/cooling switchover 
feedback

1 bit switch

9.007 Humidity status Humidity 2 byte humidity (%)
1.009 Window status Window status 1 bit open/close
1.018 Presence status Presence status 1 bit occupancy
9.001 Dew point status Dew point 2 byte temperature (°C)
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Thermostat logic (internal controller)

Fig. 127: Elements and objects – Thermostat logic

	i This element or object is only available from firmware version R4.5.
In contrast to the standard thermostat element, the thermostat logic element takes over the switching logic 
itself. In terms of function, it is an internal 2-point controller. In the minimum version, it only requires one 
temperature value data point as input and one switching data point as output. Optionally, it is also possible to 
link further data points for setpoint and operating values so that these functionalities are also available from 
or for other devices. 
The element provides for the following parameters:
	- Operation mode: KOM-STBY-ECO-PROT or COM-STBY-NIGHT-FROST
	- Heating/cooling function: heating and cooling / heating/cooling
	- Hysteresis
	- Min. setpoint value: lower limit for setpoint value range
	- Max. setpoint value: upper limit for setpoint value range
	- Setpoint value offset STBY: 
e.g. value = 2 means STBY is 2 °C below the COM setpoint during heating and 2 °C above it 
during cooling

	- Setpoint value offset NIGHT: 
e.g. value = 4 means NIGHT is 4 °C below the COM setpoint during heating and 4 °C above it 
during cooling

	- Activate effective setpoint value: see standard thermostat element
	- Activate status symbol heating/cooling: see standard thermostat element
	- Activate switchover heating/cooling: see standard thermostat element
	- Anti-frost: Enter limit value [°C] for operation mode OFF or FROST during heating
	- Protection against overheating: Enter limit value [°C] for operation mode OFF or FROST during cooling
	- Activate heating/cooling status symbol: see thermostat (satellite unit)
	- Activate heating/cooling button: see thermostat (satellite unit)
	- Activate effective setpoint (indication): see thermostat (satellite unit)
	- Setpoint slider: see thermostat (satellite unit)
	- More active status symbol window

DPT Name Object function Length Data Type
9.001 Temperature Status Temperature 2 bytes temperature (°C)
1.001 Output Switch valve 1 bit switch
1.001 Output Status Switch valve feedback 1 bit switch
20.102 Operation mode Operating mode switchover 1 byte HVAC mode
20.102 Operation mode Status KNX status operating mode 1 byte HVAC mode
9.001 Setpoint Basic setpoint 2 bytes temperature (°C)
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DPT Name Object function Length Data Type
9.001 Setpoint Status Basic setpoint feedback 2 bytes temperature (°C)
1.001 Cooling/Heating switch Heating/Cooling switchover 1 bit switch
1.001 Cooling/Heating switch 

Status
Heating/Cooling switchover 
feedback

1 bit switch

1.009 Window status Window status 1 bit open/close
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Sequence

Fig. 128: Elements and objects – Sequence

This elements offers the option of triggering a sequence (Description see page 39) using a physical 
push-button. Here, a 1-byte value is used, which must be written by the appropriate push-button to the 
corresponding communication object. The value is stored in the ETS for the physical push-button and taught 
in via the element on the visualisation.
As soon as this value is read by the KNX Smart Panel, the corresponding sequence is triggered. To be 
able to use the sequence push-button, it must be first be activated via “Settings → Plugins → Sequence 
push-button”. To use the function in a sequence, it must be enabled in the appropriate element under 
“Parameters”.

DPT Name Object function Length Data Type
18.001 SYSTEM sequence pushbutton status Scene control 1 byte scene control
232. 600 SYSTEM sequence pushbutton LED – 3 bytes RGB value 3x(0…255)

KNX scene

Fig. 129: Elements and objects – KNX scene

The functionality of the KNX scene is similar to that of the sequence but is more limited. The configuration 
of the KNX scene must be performed in the ETS. This element makes it possible to recall a specific scene 
corresponding to a number (from 1 to 64), which is also defined in the ETS programming level.
The parameters are:
	- Teach (saves the current values of the involved functions)
	- Scenario value (only for KNX – number of the scene to be recalled)

DPT Name Object function Length Data Type
18.001 KNX scene Scene extension 1 byte scene control
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Personalised slider
The personalised slider can be used for various purposes. The element can be used to write values to the 
bus (control element “Only slider”) or display values from the bus (control element “Only value display”) or 
both. An icon from the library can be used for the display.
The following parameters are available for the element:

Control elements All (sliders and value display)
Measurement unit Only slider
Decimal places Only value display
Label min. Displayed according to the value (e.g. °K)
Label max. Number of decimal places
Min. value Minimum value (smallest value of the value range)
Max. value Maximum value (largest value of the value range)
Step width (ticks) Value between two lines (scale)
Slider step width Smallest possible shift of the slider

Fig. 130: Elements and objects – Personalised slider

DPT Name Object function Length Data Type
1.001 Value Value transmitter 1 bit switching
1.001 Value Status Value transmitter feedback 1 bit switching
5.010 Value Value transmitter 1 byte counting pulses (0 .. 255)
5.010 Value Status Value transmitter feedback 1 byte counting pulses (0 .. 255)
5.001 Value Value transmitter 1 byte percent (0 .. 100)
5.001 Value Status Value transmitter feedback 1 byte percent (0 .. 100)
5.003 Value Value transmitter 1 byte angle (degrees)
5.003 Value Status Value transmitter feedback 1 byte angle (degrees)
6.010 Value Value transmitter 1 byte counter pulses (-128..127)
6.010 Value Status Value transmitter feedback 1 byte counter pulses (-128..127)
7.001 Value Value transmitter 2 bytes pulses
7.001 Value Status Value transmitter feedback 2 bytes pulses
8.001 Value Value transmitter 2 bytes pulses difference
8.001 Value Status Value transmitter feedback 2 bytes pulses difference
9.* Value Value transmitter 2 bytes 2-byte float value
9.* Value Status Value transmitter feedback 2 bytes 2-byte float value
12.001 Value Value transmitter 4 bytes counter pulses (unsigned)
12.001 Value Status Value transmitter feedback 4 bytes counter pulses (unsigned)
13.001 Value Value transmitter 4 bytes counter pulses (signed)
13.001 Value Status Value transmitter feedback 4 bytes counter pulses (signed)
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DPT Name Object function Length Data Type
14* Value Value transmitter 4 bytes 4-byte float value
14* Value Status Value transmitter feedback 4 bytes 4-byte float value
16.000 Value Status Value transmitter feedback 14 byte Characters (ASCII)
16.001 Value Status Value transmitter feedback 14 byte Characters (ISO 8859-1)
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Music
The parameters for the music element are:

Invert play/pause 0 = Pause, 1 = Play or 1 = Pause, 0 = Play
Activate volume control Activates/deactivates the volume control
Activate next/previous title Activates/deactivates next/previous title
Value for previous title Activated: Sends 1, deactivated: Sends 0
Activate title information Activates/deactivates title and artist

Fig. 131: Elements and objects – Music

DPT Name Object function Length Data Type
1.001 Play/Pause Play/Pause 1 bit switch
1.001 Play/Pause Status Play/Pause feedback 1 bit switch 
5.001 Volume Volume control 1 byte percentage (0..100%)
5.001 Volume Status Volume feedback 1 byte percentage (0..100%)
1.001 Next track Next title 1 bit switch
1.001 Previous track Previous title 1 bit switch
16* Track title Status Song title 14 byte character string
16* Track interpret Status Artist 14 byte character string
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Command button
This element functions like a physical push-button. 
The following parameters are available for the element:

Icon Select an icon from the library
"Button pressed" value Value to be sent on pressing
"Button released" value Value to be sent on releasing

Fig. 132: Elements and objects – Command button

DPT Name Object function Length Data Type
1.001 Value Value transmitter 1 bit switch
1.002 Value Value transmitter 1 bit boolean
1.003 Value Value transmitter 1 bit enable
1.004 Value Value transmitter 1 bit ramp
1.005 Value Value transmitter 1 bit alam
1.006 Value Value transmitter 1 bit binary value
1.007 Value Value transmitter 1 bit step
1.008 Value Value transmitter 1 bit up/down
1.009 Value Value transmitter 1 bit open/close
1.010 Value Value transmitter 1 bit sart/stop
1.011 Value Value transmitter 1 bit state
1.012 Value Value transmitter 1 bit invert
1.013 Value Value transmitter 1 bit dim send style
1.014 Value Value transmitter 1 bit input source
1.015 Value Value transmitter 1 bit reset
1.016 Value Value transmitter 1 bit acknowledge
1.017 Value Value transmitter 1 bit trigger
1.018 Value Value transmitter 1 bit occupancy
1.019 Value Value transmitter 1 bit window/door
1.021 Value Value transmitter 1 bit logical function
1.022 Value Value transmitter 1 bit scene
1.023 Value Value transmitter 1bit shutter/blinds mode
1.024 Value Value transmitter 1 bit day/night
1.100 Value Value transmitter 1 bit cooling/heating
5.001 Value Value transmitter 1 byte Percentage (0 .. 100%)
5.003 Value Value transmitter 1 byte angle (degrees)
5.005 Value Value transmitter 1 byte ratio (0..255)
5.006 Value Value transmitter 1 byte tariff (0..255)
5.010 Value Value transmitter 1 byte counter pulses (0..255)
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Placeholder
	i This element or object is only available from firmware version R4.5.

A placeholder element is used to graphically/visually separate the other elements. Accordingly, it can be 
positioned and moved as a free tile between other elements on the GUI. Placeholders do not have any KNX 
function and therefore do not offer any data points. Placeholders are graphic elements only. 
The following parameters are available for the element:
	- Activate/deactivate background: Assumes colour of the selected design, i.e. light or dark
	- Title: Visualises the name of the placeholder element. No text display element!
	- Only show on KNX Smart Panel 8

Temperature, time and date

          
Fig. 133: Elements and objects – Temperature, time and date

DPT Name Object function Length Data Type
9.001 STATUS BAR Indoor temperature Status temperature (°C) 2 bytes temperature (°C)
9.001 STATUS BAR Outdoor temperature Status temperature (°C) 2 bytes temperature (°C)
10.001 SYSTEM Time time 3 bytes time of day
11.001 SYSTEM Date date 3 bytes date
19.001 SYSTEM Date/Time date/time 8 bytes date time

Presence simulation

Fig. 134: Elements and objects – Presence simulation

DPT Name Object function Length Data Type
1.001 SYSTEM Presence simulation - Synch. Status Switching 1 bit switch
1.001 SYSTEM Presence simulation - Synch. State (Status) Switching feedback 1 bit switch
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8	 Cleaning
	i The cleaning mode is started with the “Screencleaner” app.

Suitable cleaning agents: 
Water, degreaser, glass cleaner, alcohol and isopropyl alcohol
Not suitable for cleaning: 
Abrasive cloths or harsh detergents
•	 Start the cleaning mode or switch off the device to lock the touch screen.
•	 Apply cleaning agent or water to a cloth. 
Do not apply directly to the device.

•	 Clean the front with a cloth. 
Cleaning agent must not get into the device.

•	 Switch the device on again after cleaning or wait for the cleaning mode to end automatically after 
30 seconds.

9	 Technical data
Screen diagonal 203 mm / 8“
Resolution 1280 x 800 (WXGA)
Aspect ratio 16:10
Overall dimensions  
(W x H)

Smart Panel 
Adapter

225 x 145 mm 
216 x 141 mm

Installation height 16 mm
Installation depth 22 mm
Power consumption max. 16 W
Power supply DC 12 … 32 V SELV 

via external power adapter
Operating system Android
Processor Cortex-A53
Main memory 2 GB
Mass storage 16 GB Flash
Loudspeaker integrated
Microphone integrated
USB connection 1 x USB 2.0 type A
LAN connection 1 x 10/100/1000 Mbit/s
KNX KNX connection terminal
KNX medium TP 256
Ambient temperature 0 ... +30 °C
Atmospheric humidity 5 ... 80 % (no condensation)

10	 Accessories
Power supply adapter NT 2415 REG VDC
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11	 Terms and definitions
Term Description

DCA 
(Device Configuration App)

Additional program for the ETS for commissioning. The DCA is displayed 
as an additional tab in the ETS. The DCA allows the import of the project 
file (*.ksp) into the ETS from the Smart Panel Designer.

DPT 
(Data point types)

Standardised format for communication objects. Allows the evaluation of 
the data of a communication object.

Pairing Creation of an initial connection between two devices. The Smart Panel 
can be connected to a mobile device (smartphone, tablet, etc.). This 
allows remote control using the JUNG Smart Vision app. For this, both 
devices must be in the local network (Wi-Fi).

12	 Disposal obligations
	 The symbol with the crossed-out wheeled bin indicates that the product must be disposed of 
separately from household waste at the end of its useful service life in order to enable correct 
treatment and recycling.

At the end of its service life, the user must therefore take the device free of charge to the municipal collection 
points responsible for the separate collection of electrical and electronic waste or return it to the dealer.
Separate collection for recycling helps to avoid possible negative impacts on the environment and health, 
and facilitates the reuse, recycling and/or recovery of the materials in the devices.
Wherever possible, batteries and rechargeable batteries must be removed from the device prior to disposal.

13	 Warranty
The warranty follows about the specialty store in between the legal framework as provided for by law.


